Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither is any liability assumed for damages resulting from the use of the information herein. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

© 2019 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.
Trademarks

- EPSON® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark of Seiko Epson Corporation.
- Epson Scan 2 software is based in part on the work of the Independent JPEG Group.
- libtiff
  Copyright © 1988-1997 Sam Leffler
  Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.
  THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
  IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
- QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.
- Intel® is a registered trademark of Intel Corporation.
- Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.
- Apple, Macintosh, macOS, OS X, Bonjour, ColorSync, Safari, AirPrint, the AirPrint Logo, iPad, iPhone, iPod touch, and iTunes are trademarks of Apple Inc., registered in the U.S. and other countries.
- Google Cloud Print, Chrome, Chrome OS, Google Play and Android are trademarks of Google LLC.
- Adobe and Adobe Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.
Contents

Copyright

Trademarks

About This Manual
Introduction to the Manuals................................. 8
Using the Manual to Search for Information.................. 8
Marks and Symbols........................................ 9
Descriptions Used in this Manual...............................10
Operating System References.................................10

Important Instructions
Safety Instructions.............................................11
Printer Advisories and Warnings.............................12
Advisories and Warnings for Setting Up the Printer........12
Advisories and Warnings for Using the Printer...............12
Advisories and Warnings for Transporting or Storing the Printer........... 13
Advisories and Warnings for Using the Printer with a Wireless Connection........... 13
Advisories and Warnings for Using the LCD Screen...............13
Protecting Your Personal Information........................13

Printer Basics
Part Names and Functions....................................14
Guide to the Control Panel...................................16
Control Panel..............................................16
Guide to the Home Screen..................................16
Entering Characters.........................................17
Viewing Animations.........................................18

Network Settings
Network Connection Types....................................20
Wi-Fi Connection...........................................20
Wi-Fi Direct (Simple AP) Connection.........................20
Connecting to a Computer...................................21
Connecting to a Smart Device................................22
Connecting to a smart device over a wireless router...........22
Connecting to an iPhone, iPad, or iPhone touch using Wi-Fi Direct...........................................22
Connecting to Android Devices using Wi-Fi Direct.........................26
Connecting to Devices other than iOS and Android using Wi-Fi Direct...........................................28
Making Wi-Fi Settings from the Printer........................31
Making Wi-Fi Settings by Entering the SSID and Password...........31
Making Wi-Fi Settings by Push Button Setup......................32
Making Wi-Fi Settings by PIN Code Setup (WPS)......................33
Checking the Network Connection Status.......................34
Network Icon...............................................34
Printing a Network Connection Report.........................34
Printing a Network Status Sheet.............................40
Replacing or Adding New Wireless Routers........................40
Changing the Connection Method to a Computer.................41
Changing the Wi-Fi Direct (Simple AP) Settings..................41
Disabling Wi-Fi from the Control Panel........................42
Disconnecting Wi-Fi Direct (Simple AP) Connection from the Control Panel..............................43
Restoring the Network Settings from the Control Panel...........43

Loading Paper
Paper Handling Precautions..................................44
Available Paper and Capacities...............................45
Genuine Epson Paper.......................................45
Commercially Available Paper................................46
Paper for Borderless Printing................................46
Paper for 2-Sided Printing..................................47
List of Paper Type..........................................47
Loading Paper in the Rear Paper Feed........................47

Placing Originals
Placing Originals on the Scanner Glass.......................51
How to Place Various Originals...............................52

Printing
Printing from the Control Panel.............................55
Printing Lined Paper and Calendars..........................55
Printing from a Computer...................................55
Printing Basics - Windows..................................55
## Contents

### Printing Basics - Mac OS
- Printing Basics ........................................ 57
- Printing on 2-Sides ................................... 59
- Printing Several Pages on One Sheet .............. 61
- Printing to Fit the Paper Size ....................... 62
- Printing Multiple Files Together (for Windows Only) . 64
- Printing One Image on Multiple Sheets to Create a Poster (for Windows Only) .............. 65
- Printing Using Advanced Features .................. 71
- Printing from Smart Devices ....................... 74
  - Using Epson iPrint ................................ 74
  - Using Epson Print Enabler .......................... 75
  - Using AirPrint ..................................... 76
- Canceling Printing .................................. 77
  - Canceling Printing - Control Panel ............... 77
  - Canceling Printing - Windows ..................... 77
  - Canceling Printing - Mac OS ..................... 77

### Copying
- Copying Basics ....................................... 78
- Copying in Various Layout ............................ 78
- Menu Options for Copying ............................ 79

### Scanning
- Scanning Using the Control Panel ................... 82
  - Scanning to a Computer ............................ 82
  - Scanning Using WSD ............................... 86
- Scanning from a Computer ........................... 88
  - Scanning Using Epson Scan 2 ....................... 88
  - Scanning from Smart Devices ...................... 95
  - Installing Epson iPrint ............................ 95
  - Scanning Using Epson iPrint ....................... 95

### Replacing Ink Cartridges and Other Consumables
- Checking the Status of the Remaining Ink and the Maintenance Box .................. 97
  - Checking the Status of the Remaining Ink and the Maintenance Box - Control Panel .............. 97
  - Checking the Status of the Remaining Ink and the Maintenance Box - Windows ................... 97
  - Checking the Status of the Remaining Ink and the Maintenance Box - Mac OS X ................... 97
- Ink Cartridge Codes .................................. 98
- Ink Cartridge Handling Precautions ................ 99
- Replacing Ink Cartridges ............................ 101
- Maintenance Box Code ................................ 104
- Maintenance Box Handling Precautions ............ 104
- Replacing a Maintenance Box ....................... 105
- Temporarily Printing with Black Ink ............... 108
  - Temporarily Printing with Black Ink - Windows 109
  - Temporarily Printing with Black Ink - Mac OS ... 110
- Conserving Black Ink when the Black Ink Is Low (for Windows Only) .................. 110

### Maintaining the Printer
- Preventing the Print Head from Drying .............. 112
- Checking and Cleaning the Print Head ............... 112
  - Checking and Cleaning the Print Head - Control Panel .................. 112
  - Checking and Cleaning the Print Head - Windows ................... 113
  - Checking and Cleaning the Print Head - Mac OS .................. 113
- Aligning the Print Head ............................. 114
  - Aligning the Print Head - Control Panel .......... 114
- Cleaning the Paper Path for Ink Smears ............. 114
- Cleaning the Scanner Glass .......................... 115
- Cleaning the Translucent Film ....................... 115
- Saving Power ......................................... 117
  - Saving Power - Control Panel ..................... 118

### Menu Options for Settings
- Menu Options for Supply Status ..................... 119
- Ink Level ............................................. 119
- Maintenance Box Service Life ........................... 119
- Menu Options for Maintenance ....................... 119
  - Nozzle Check ..................................... 119
  - Head Cleaning .................................... 119
  - Print Head Alignment .............................. 119
  - Ink Cartridge(s) Replacement ...................... 119
  - Paper Guide Cleaning .............................. 120
- Menu Options for Printer Setup ....................... 120
  - Paper Source Settings ............................. 120
  - Quiet Mode ....................................... 120
  - Power Off Timer .................................. 120
  - Power Off Settings ............................... 120
  - Language ......................................... 121
  - Keyboard ......................................... 121
  - Sleep Timer ....................................... 121
  - Ink Drying Time ................................... 121
- Menu Options for Network Settings ................... 121
- Menu Options for Epson Connect Services ............ 122
- Menu Options for Google Cloud Print Services .... 122
### Contents

- **Menu Options for Guide Functions** ............................................ 123
- **Menu Options for Customer Research** .................................... 123
- **Menu Options for Firmware Update** ....................................... 123
- **Menu Options for Restore Default Settings** ............................ 123

#### Network Service and Software Information

- **Epson Connect Service** .......................................................... 125
- **Application for Configuring Printer Operations**
  - (Web Config) ........................................................................... 125
  - Running Web Config on a Web Browser ................................ 126
  - Running Web Config on Windows ........................................ 126
  - Running Web Config on Mac OS .......................................... 127
- **Windows Printer Driver** ......................................................... 127
  - Guide to Windows Printer Driver ......................................... 128
  - Making Operation Settings for the Windows Printer Driver .... 129
- **Mac OS Printer Driver** .......................................................... 130
  - Guide to Mac OS Printer Driver ........................................... 131
  - Making Operation Settings for the Mac OS Printer Driver .... 132
- **Application for Scanning Documents and Images (Epson Scan 2)** 133
  - Adding the Network Scanner .............................................. 133
- **Application for Configuring Scanning Operations from the Control Panel (Epson Event Manager)** ................................. 134
- **Application for Printing Images (Epson Photo+)** .................. 134
- **Software Update Tools (EPSON Software Updater)** ............. 135
- **Installing Applications** ....................................................... 135
- **Updating Applications and Firmware** ................................... 136
  - Updating the Printer’s Firmware using the Control Panel ...... 136
- **Uninstalling Applications** ..................................................... 137
  - Uninstalling Applications - Windows .................................. 137
  - Uninstalling Applications - Mac OS .................................... 138

#### Solving Problems

- **Checking the Printer Status** .................................................. 139
- **Checking Error Codes on the LCD Screen** ........................... 139
- **Checking the Printer Status - Windows** ................................. 140
- **Checking the Printer Status - Mac OS** .................................. 140
- **Checking the Software Status** ............................................. 141
- **Removing Jammed Paper** .................................................... 141
  - Removing Jammed Paper from the Rear Paper Feed ............. 141
  - Removing Jammed Paper from Inside the Printer .................. 141
  - Removing Jammed Paper from Rear Cover ......................... 143
- **Paper Does Not Feed Correctly** .......................................... 144
  - Paper Jams ......................................................................... 144
  - Paper Feeds at a Slant ....................................................... 145
  - Several Sheets of Paper are Fed at a Time ......................... 145
  - Paper Out Error Occurs .................................................... 145
  - Paper is Ejected During Printing ........................................ 145
- **Power and Control Panel Problems** ..................................... 145
  - Power Does Not Turn On .................................................... 145
  - Power Does Not Turn Off ................................................... 145
  - Power Turns Off Automatically .......................................... 145
  - LCD Screen Gets Dark ...................................................... 146
- **Cannot Print from a Computer** ............................................. 146
  - Checking the Connection (USB) ......................................... 146
  - Checking the Connection (Network) .................................... 146
  - Checking the Software and Data ......................................... 147
  - Checking the Printer Status from the Computer (Windows) ... 149
  - Checking the Printer Status from the Computer (Mac OS) ...... 149
- **When You Cannot Make Network Settings** ............................ 150
  - Cannot Connect from Devices Even Though Network Settings are No Problems .............................................. 150
  - Checking the SSID Connected to the Printer ....................... 152
  - Checking the SSID for the Computer .................................. 152
  - Wireless LAN (Wi-Fi) Connections Become Unstable When Using USB 3.0 Devices on a Mac ................................. 153
- **Cannot Print from an iPhone, iPad, or iPod touch** .................. 153
- **Printout Problems** .............................................................. 154
  - Printout is Scuffed or Color is Missing ................................ 154
  - Banding or Unexpected Colors Appear ................................ 154
  - Colored Banding Appears at Intervals of Approximately 2.5 cm 154
  - Blurry Prints, Vertical Banding, or Misalignment .................. 155
  - Print Quality is Poor ......................................................... 155
  - Paper Is Smeared or Scuffed .............................................. 156
  - Paper is Smeared During Automatic 2-Sided Printing ............ 156
- **Printed Photos are Sticky** .................................................... 157
- **Images or Photos are Printed in Unexpected Colors** ........... 157
- **Colors Differ from What You See on the Display** ............... 157
- **Cannot Print Without Margins** ............................................ 158
- **Edges of the Image are Cropped During Borderless Printing** 158
Appendix

Technical Specifications. 168
Printer Specifications. 168
About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of help information available from the printer itself or from the Epson software applications.

- **Start Here (paper manual)**
  Provides you with information on setting up the printer, installing the software, using the printer, solving problems, and so on.

  This manual. Provides overall information and instructions on using the printer, on network settings when using the printer on a network, and on solving problems.

You can obtain the latest versions of the above manuals with the following methods.

- **Paper manual**

- **Digital manual**
  Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information

⇒ “Software Update Tools (EPSON Software Updater)” on page 135

Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific sections using the bookmarks. You can also print only the pages you need. This section explains how to use a PDF manual that has been opened in Adobe Reader X on your computer.

**Searching by keyword**

Click **Edit > Advanced Search**. Enter the keyword (text) for information you want to find in the search window, and then click **Search**. Hits are displayed as a list. Click one of the displayed hits to jump to that page.
Jumping directly from bookmarks
Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous page, perform the following operation on your keyboard.

- Windows: Hold down Alt, and then press ←.
- Mac OS: Hold down the command key, and then press ←.

Printing only the pages you need
You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you want to print in Pages in Pages to Print.

- To specify a series of pages, enter a hyphen between the start page and the end page.
  Example: 20-25
- To specify pages that are not in series, divide the pages with commas.
  Example: 5, 10, 15

Marks and Symbols

⚠️ Caution:
Instructions that must be followed carefully to avoid bodily injury.

⚠️ Important:
Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.
Related Information

- Links to related sections.

Descriptions Used in this Manual

- Screenshots of the printer driver and the Epson Scan 2 (scanner driver) screens are from Windows 10 or macOS Mojave. The content displayed on the screens varies depending on the model and situation.
- Illustrations used in this manual are examples only. Although there may be slight differences depending on the model, the method of operation is the same.
- Some of the menu items on the LCD screen vary depending on the model and settings.
- You can read the QR code using dedicated app.

Operating System References

**Windows**

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista", and "Windows XP" refer to the following operating systems. Additionally, "Windows" is used to refer to all versions.

- Microsoft® Windows® 10 operating system
- Microsoft® Windows® 8.1 operating system
- Microsoft® Windows® 8 operating system
- Microsoft® Windows® 7 operating system
- Microsoft® Windows Vista® operating system
- Microsoft® Windows® XP operating system
- Microsoft® Windows® XP Professional x64 Edition operating system

**Mac OS**

In this manual, "Mac OS" is used to refer to macOS Mojave, macOS High Sierra, macOS Sierra, OS X El Capitan, OS X Yosemite, OS X Mavericks, OS X Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.
Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future reference. Also, be sure to follow all warnings and instructions marked on the printer.

- Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following Web site to learn the meaning of the symbols.
  [http://support.epson.net/symbols](http://support.epson.net/symbols)
- Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of other cords with this printer or the use of the supplied power cord with other equipment may result in fire or electric shock.
- Be sure your AC power cord meets the relevant local safety standard.
- Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by yourself, except as specifically explained in the printer’s manuals.
- Unplug the printer and refer servicing to qualified service personnel under the following conditions:
  - The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust controls that are not covered by the operating instructions.
- Place the printer near a wall outlet where the plug can be easily unplugged.
- Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations subject to shocks, vibrations, high temperature or humidity.
- Take care not to spill liquid on the printer and not to handle the printer with wet hands.
- Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely affect the operation of cardiac pacemakers.
- If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

Safety Instructions for Ink

- Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port.
  - If ink gets on your skin, wash the area thoroughly with soap and water.
  - If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a thorough flushing, see a doctor immediately.
  - If ink gets into your mouth, see a doctor right away.
- Do not disassemble the ink cartridge and the maintenance box; otherwise ink may get into your eyes or on your skin.
- Do not shake ink cartridges too vigorously and do not drop them. Also, be careful not to squeeze them or tear their labels. Doing so may cause ink leakage.
- Keep ink cartridges and maintenance box out of the reach of children.
Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this manual for future reference.

Advisories and Warnings for Setting Up the Printer

- Do not block or cover the vents and openings in the printer.
- Use only the type of power source indicated on the printer's label.
- Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Avoid electrical outlets controlled by wall switches or automatic timers.
- Keep the entire computer system away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
- The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and leave the transformer.
- If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
- If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit breaker to provide adequate short-circuit protection and over-current protection for the printer.
- When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.
- Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer will not operate properly if it is tilted at an angle.
- Allow space above the printer so that you can fully raise the document cover.
- Leave enough space in front of the printer for the paper to be fully ejected.
- Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct sunlight, strong light, or heat sources.

Advisories and Warnings for Using the Printer

- Do not insert objects through the slots in the printer.
- Do not put your hand inside the printer during printing.
- Do not touch the white flat cable inside the printer.
- Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
- Do not move the print head by hand; otherwise, you may damage the printer.
- Be careful not to trap your fingers when closing the scanner unit.
- Do not press too hard on the scanner glass when placing the originals.
Always turn the printer off using the \( \mathcal{O} \) button. Do not unplug the printer or turn off the power at the outlet until the \( \mathcal{O} \) light stops flashing.

If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical outlet.

**Advisories and Warnings for Transporting or Storing the Printer**

- When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down; otherwise ink may leak.
- Before transporting the printer, make sure that the print head is in the home (far right) position.

**Advisories and Warnings for Using the Printer with a Wireless Connection**

- Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing them to malfunction. When using this printer inside medical facilities or near medical equipment, follow directions from the authorized personnel representing the medical facilities, and follow all posted warnings and directions on the medical equipment.
- Radio waves from this printer may negatively affect the operation of automatically controlled devices such as automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near automatically controlled devices, follow all posted warnings and directions on these devices.

**Advisories and Warnings for Using the LCD Screen**

- The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven brightness. These are normal and do not indicate that it is damaged in any way.
- Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.
- The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the screen's surface chips or cracks, and do not touch or attempt to remove the broken pieces.

**Protecting Your Personal Information**

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's memory by selecting **Settings > Restore Default Settings > All Settings** on the control panel.
Printer Basics

Part Names and Functions

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rear paper feed</td>
<td>Loads paper.</td>
</tr>
<tr>
<td>2</td>
<td>Paper support</td>
<td>Supports loaded paper.</td>
</tr>
<tr>
<td>3</td>
<td>Edge guide</td>
<td>Feeds the paper straight into the printer. Slide to the edges of the paper.</td>
</tr>
<tr>
<td>4</td>
<td>Feeder guard</td>
<td>Prevents foreign substance from entering the printer. Usually keep this guard closed.</td>
</tr>
<tr>
<td>5</td>
<td>Output tray</td>
<td>Holds the ejected paper.</td>
</tr>
<tr>
<td>6</td>
<td>Stopper</td>
<td>Prevents printouts from falling from the output tray.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Document cover</td>
<td>Blocks external light while scanning.</td>
</tr>
<tr>
<td>2</td>
<td>Scanner glass</td>
<td>Place the originals.</td>
</tr>
<tr>
<td>3</td>
<td>Control panel</td>
<td>Indicates the printer’s status and allows you to make print settings.</td>
</tr>
</tbody>
</table>
## Printer Basics

<table>
<thead>
<tr>
<th></th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Scanner unit support</td>
<td>Supports the scanner unit.</td>
</tr>
<tr>
<td>2</td>
<td>Scanner unit</td>
<td>Scans placed originals. Open when replacing ink cartridges or removing jammed paper inside the printer.</td>
</tr>
<tr>
<td>3</td>
<td>Ink cartridge holder</td>
<td>Install the ink cartridges. Ink is ejected from the print head nozzles.</td>
</tr>
<tr>
<td></td>
<td>Maintenance box cover</td>
<td>Remove when replacing the maintenance box. The maintenance box is a container that collects a very small amount of surplus ink during cleaning or printing.</td>
</tr>
<tr>
<td>2</td>
<td>Rear cover</td>
<td>Remove when removing jammed paper.</td>
</tr>
<tr>
<td>3</td>
<td>AC inlet</td>
<td>Connects the power cord.</td>
</tr>
<tr>
<td>4</td>
<td>USB port</td>
<td>Connects a USB cable to connect with a computer.</td>
</tr>
</tbody>
</table>

### Related Information

- "Control Panel" on page 16
# Guide to the Control Panel

## Control Panel

| 1 | Turns the printer on or off. Unplug the power cord after checking that the power light is off. |
| 2 | Displays the home screen. |
| 3 | Displays menus and messages. Use buttons on the control panel to select a menu or to make settings. |
| 4 | Displays the solutions when you are in trouble. |
| 5 | Use the ▲▼◄► buttons to select a menu, and then press the OK button to enter the selected menu. |
| 6 | Stops the current operation. |
| 7 | Starts an operation such as printing or copying. |
| 8 | Applies to a variety of functions depending on the situation. |
| 9 | Returns to the previous screen. |

---

## Guide to the Home Screen

1. Displays the home screen.
2. Displays menus and messages. Use buttons on the control panel to select a menu or to make settings.
3. Displays the solutions when you are in trouble.
4. Use the ▲▼◄► buttons to select a menu, and then press the OK button to enter the selected menu.
5. Stops the current operation.
6. Starts an operation such as printing or copying.
7. Applies to a variety of functions depending on the situation.
8. Returns to the previous screen.
Icons that show the network status are displayed.

1. Indicates that a wireless (Wi-Fi) network is disabled, or that the printer is processing a wireless network connection.
2. Indicates a problem with the printer’s wireless (Wi-Fi) network connection, or that the printer is searching for a wireless (Wi-Fi) network connection.
3. Indicates that the printer is connected to a wireless (Wi-Fi) network.
   The number of bars indicates the signal strength of the connection. The more bars there are, the stronger the connection.
4. Indicates that Wi-Fi Direct (Simple AP) is enabled.
5. Indicates that Wi-Fi Direct (Simple AP) is disabled.

When ◀ and ▶ are displayed, you can scroll right or left by pressing the ◀ or ▶ button.

Function icons and names are displayed as menu icons.
Select an icon by pressing the ▲, ▼, ◀, or ▶ buttons, and then press the OK button to enter the menu.

Scan | Allows you to scan a document or a photo.
Copy | Allows you to copy a document.
Smartphone connect | Allows you to connect the printer directly to your smart device without a wireless router.
Quiet Mode | Displays Quiet Mode setting that allows you to reduce the noise the printer makes. However, enabling this may reduce print speed. Depending on the paper type and print quality settings you selected, there may be no difference in the printer’s noise level.
   This is a shortcut to the following menu.
   Settings > Printer Setup > Quiet Mode
Personal Stationery | Offers you various printing features such as printing ruled paper or calendars.
Settings | Allows you to make settings related to maintenance, printer setup, and network settings.
Maintenance | Displays the menus recommended to improve the quality of your printouts such as unclogging nozzles by printing a nozzle check pattern and performing head cleaning, and improving blurring or banding in your printouts by aligning the print head. This is a shortcut to the following menu.
   Settings > Maintenance
Wi-Fi Setup | Allows you to set up the printer for use on a wireless network. This is a shortcut to the following menu.
   Settings > Network Settings > Wi-Fi Setup

Available buttons are displayed. In this example, you can proceed to the selected menu by pressing the OK button.

Entering Characters

To enter characters and symbols for network settings from the control panel, use the ▲, ▼, ◀, and ▶ buttons and the software keyboard on the LCD screen. Press the ▲, ▼, ◀, or ▶ button to select a character or function button.
on the keyboard, and then press the OK button. When you have finished entering characters, select **OK**, and then press the OK button.

**Function button**  
**Descriptions**

<table>
<thead>
<tr>
<th>Function button</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>◀▶</td>
<td>Moves the cursor to the left or right.</td>
</tr>
<tr>
<td>A 1 #</td>
<td>Switches the character type. You can enter alphanumerics or symbols. You can also switch them by using the ◀ button.</td>
</tr>
<tr>
<td></td>
<td>Enters a space.</td>
</tr>
<tr>
<td>✗</td>
<td>Deletes a character to the left (backspace).</td>
</tr>
<tr>
<td>OK</td>
<td>Enters the selected characters.</td>
</tr>
</tbody>
</table>

**Viewing Animations**

You can view animations of operating instructions such as loading paper or removing jammed paper on the LCD screen.

- Press ◇ button: Displays the help screen. Select **How To** and then select the items that you want to view.
- Select **How to** at the bottom of the operation screen: Displays the context-sensitive animation.

1 Indicates your progress through the current step. The animation repeats when the progress bar reaches the end.
### Printer Basics

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Press button to return to the previous step.</td>
</tr>
</tbody>
</table>
| 3 | Indicates the total number of steps and the current step number.  
  In the example above, it shows step 2 from 3 steps. |
| 4 | Press button to move to the next step. |
Network Settings

Network Connection Types

You can use the following connection methods.

Wi-Fi Connection

Connect the printer and the computer or smart device to the wireless router. This is the typical connection method for home or office networks where computers are connected by Wi-Fi through the wireless router.

Related Information

- “Connecting to a Computer” on page 21
- “Connecting to a smart device over a wireless router” on page 22
- “Making Wi-Fi Settings from the Printer” on page 31

Wi-Fi Direct (Simple AP) Connection

Use this connection method when you are not using Wi-Fi at home or at the office, or when you want to connect the printer and the computer or smart device directly. In this mode, the printer acts as an wireless router and you
can connect the devices to the printer without having to use a standard wireless router. However, devices directly connected to the printer cannot communicate with each other through the printer.

The printer can be connected by Wi-Fi and Wi-Fi Direct (Simple AP) connection simultaneously. However, if you start a network connection in Wi-Fi Direct (Simple AP) connection when the printer is connected by Wi-Fi, the Wi-Fi is temporarily disconnected.

Related Information
- “Connecting to an iPhone, iPad, or iPod touch using Wi-Fi Direct” on page 22
- “Connecting to Android Devices using Wi-Fi Direct” on page 26
- “Connecting to Devices other than iOS and Android using Wi-Fi Direct” on page 28

Connecting to a Computer

We recommend using the installer to connect the printer to a computer. You can run the installer using one of the following methods.

- Setting up from the website
  Access the following website, and then enter the product name. Go to Setup, and then start setting up.
  http://epson.sn

- Setting up using the software disc (only for the models that come with a software disc and users with Windows computers with disc drives.)
  Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting the Connection Methods

Follow the on-screen instructions until the following screen is displayed, and then select the connection method of the printer to the computer.
Select the connection type and then click Next.

Follow the on-screen instructions.

Connecting to a Smart Device

Connecting to a smart device over a wireless router

You can use the printer from a smart device when you connect the printer to the same Wi-Fi network (SSID) as the smart device. To use the printer from a smart device, set up from the following website. Access to the website from the smart device that you want to connect to the printer.

http://epson.sn > Setup

Note:
If you want to connect a computer and a smart device to the printer at the same time, we recommend setting up from the computer first by using the installer.

Related Information
➤ “Printing from Smart Devices” on page 74

Connecting to an iPhone, iPad, or iPod touch using Wi-Fi Direct

This method allows you to connect the printer directly to an iPhone, iPad, or iPod touch without a wireless router. The following conditions are required to connect using this method. If your environment does not match these
conditions, you can connect by selecting **Other OS Devices**. See "Related Information" below for details on connecting.

- iOS 11 or later
- Using the standard camera application to scan the QR code
- Epson iPrint version 7.0 or later

Epson iPrint is used to print from a smart device. Install Epson iPrint on the smart device in advance.

**Note:**
You only need to make these settings for the printer and the smart device that you want to connect to once. Unless you disable Wi-Fi Direct or restore the network settings to their defaults, you do not need to make these settings again.

1. Select **Smartphone connect** on the home screen using the 
   buttons, and then press the OK button.

2. Check the message, and then press the OK button to proceed.

3. Check the message, and then press the OK button to proceed.

4. Select **iOS** using the 
   buttons, and then press the OK button.
5. Check the message, and then press the OK button to proceed.
   The QR code is displayed on the printer’s control panel.

![QR code image]

6. On your iPhone, iPad, or iPod touch, start the standard Camera app, and then scan the QR code displayed on the printer’s control panel in PHOTO mode.

![Smartphone with QR code]

Use the Camera app for iOS 11 or later. You cannot connect to the printer using the Camera app for iOS 10 or earlier. Also, you cannot connect using an app for scanning QR codes. If you cannot connect, press the ▶️ button. See "Related Information" below for details on connecting.

7. Tap the notification displayed on the screen of the iPhone, iPad, or iPod touch.

![Notification image]

8. Tap Join.
9. On the printer’s control panel, press the OK button.

10. On the iPhone, iPad, or iPod touch, start Epson printing app.

   Examples of Epson printing apps

   ![Epson iPrint](image1)
   ![Epson Creative Print](image2)

11. On the Epson printing app screen, tap **Printer is not selected**.

12. Select the printer that you want to connect to.

   ![Select Printer](image3)

   See the information displayed on the printer’s control panel to select the printer.

13. On the printer’s control panel, press the OK button.

   For smart devices that have been connected to the printer before, select the network name (SSID) on the smart device’s Wi-Fi screen to connect them again.
Related Information

➤ “Connecting to Devices other than iOS and Android using Wi-Fi Direct” on page 28
➤ “Printing from Smart Devices” on page 74

Connecting to Android Devices using Wi-Fi Direct

This method allows you to connect the printer directly to your Android device without a wireless router. The following conditions are required to use this function.

- Android 4.4 or later
- Epson iPrint version 7.0 or later

Epson iPrint is used to print from a smart device. Install Epson iPrint on the smart device in advance.

Note:
You only need to make these settings for the printer and the smart device that you want to connect to once. Unless you disable Wi-Fi Direct or restore the network settings to their defaults, you do not need to make these settings again.

1. Select **Smartphone connect** on the home screen using the **►** buttons, and then press the OK button.

2. Check the message, and then press the OK button to proceed.

3. Select **Android** using the **►** buttons, and then press the OK button.
4. On the iPhone, iPad, or iPod touch, start Epson iPrint.

5. On the Epson iPrint screen, tap **Printer is not selected.**

6. Select the printer that you want to connect to.

![Printer selection screen](image)

See the information displayed on the printer's control panel to select the printer.

![Printer information](image)

**Note:**
Printers may not been displayed depending on the Android device. If printers are not displayed, connect by selecting Other OS Devices. See "Related Information" below for connecting.

7. When the device connection approval screen is displayed, select **Approve.**

8. On the printer's control panel, press the OK button.

For smart devices that have been connected to the printer before, select the network name (SSID) on the smart device's Wi-Fi screen to connect them again.

**Related Information**

➤ “Connecting to Devices other than iOS and Android using Wi-Fi Direct” on page 28
Connecting to Devices other than iOS and Android using Wi-Fi Direct

This method allows you to connect the printer directly to smart devices without a wireless router.

**Note:**
You only need to make these settings for the printer and the smart device that you want to connect to once. Unless you disable Wi-Fi Direct or restore the network settings to their defaults, you do not need to make these settings again.

1. Select **Smartphone connect** on the home screen using the ❯❯ buttons, and then press the OK button.

2. Check the message, and then press the OK button to proceed.

3. Select **Other OS Devices** using the ❯❯ buttons, and then press the OK button.

The Network Name and Password for Wi-Fi Direct for the printer are displayed.
4. On the smart device’s Wi-Fi screen, select the Network Name shown on the printer’s control panel, and then enter the password.

The screenshot is an example on iPhone.

5. On the printer’s control panel, press the OK button.
6. On the smart device, start Epson printing app.
   Examples of Epson printing apps

   ![Epson iPrint](image1) ![Epson Creative Print](image2)

7. On the Epson printing app screen, tap **Printer is not selected**.

8. Select the printer that you want to connect to.

   ![Select Printer](image3)

   See the information displayed on the printer's control panel to select the printer.

   ![Use Wi-Fi Direct](image4)

9. On the printer's control panel, press the OK button.
   For smart devices that have been connected to the printer before, select the network name (SSID) on the smart device's Wi-Fi screen to connect them again.
Making Wi-Fi Settings from the Printer

You can make network settings from the printer’s control panel in several ways. Choose the connection method that matches the environment and conditions that you are using.

If you know the information for the wireless router such as SSID and password, you can make settings manually.

If the wireless router supports WPS, you can make settings by using push button setup.

After connecting the printer to the network, connect to the printer from the device that you want to use (computer, smart device, tablet, and so on.)

Making Wi-Fi Settings by Entering the SSID and Password

You can set up a Wi-Fi network by entering the information necessary to connect to a wireless router from the printer’s control panel. To set up using this method, you need the SSID and password for a wireless router.

Note:
If you are using an wireless router with its default settings, the SSID and password are on the label. If you do not know the SSID and password, contact the person who set up the wireless router, or see the documentation provided with the wireless router.

1. Select Wi-Fi Setup on the home screen.
   To select an item, use the ▲▼◀▶ buttons, and then press the OK button.

2. Select Wi-Fi (Recommended).

3. Press the OK button to proceed.

4. Select Wi-Fi Setup Wizard.
Network Settings

5. Select the SSID for the wireless router from printer’s control panel, and then press the OK button.

   Note:
   - If the SSID you want to connect to is not displayed on the printer’s control panel, press the button to update the list. If it is still not displayed, select Other SSIDs, and then enter the SSID directly.
   - If you do not know the SSID, check if it is written on the label of the wireless router. If you are using the wireless router with its default settings, use the SSID written on the label.

6. Enter the password.

   Select whether or not you print a network connection report after finishing the settings.

   Note:
   - The password is case-sensitive.
   - If you do not know the network name (SSID) check if the information is written on the label of the wireless router. If you are using the wireless router with its default settings, use the SSID on the label. If you cannot find any information, see the documentation provided with the wireless router.

7. When you have setup finished, and then press the button.

   Note:
   - If you fail to connect, load paper, and then press the button to print a network connection report.

Related Information

⇒ “Entering Characters” on page 17
⇒ “Checking the Network Connection Status” on page 34
⇒ “When You Cannot Make Network Settings” on page 150

Making Wi-Fi Settings by Push Button Setup

You can automatically set up a Wi-Fi network by pressing a button on the wireless router. If the following conditions are met, you can set up by using this method.

- The wireless router is compatible with WPS (Wi-Fi Protected Setup).
- The current Wi-Fi connection was established by pressing a button on the wireless router.

1. Select Wi-Fi Setup on the home screen.

   To select an item, use the ▲ ▼ ◀▶ buttons, and then press the OK button.

2. Select Wi-Fi (Recommended).

3. Press the OK button to proceed.

5. Hold down the [WPS] button on the wireless router until the security light flashes.

If you do not know where the [WPS] button is, or there are no buttons on the wireless router, see the documentation provided with your wireless router for details.

6. Press the OK button on the printer's control panel. Follow the on-screen instruction hereafter.

   **Note:**
   If connection fails, restart the wireless router, move it closer to the printer, and try again. If it still does not work, print a network connection report and check the solution.

**Related Information**
- “Checking the Network Connection Status” on page 34
- “When You Cannot Make Network Settings” on page 150

**Making Wi-Fi Settings by PIN Code Setup (WPS)**

You can automatically connect to an wireless router by using a PIN code. You can use this method to set up if an wireless router is capable of WPS (Wi-Fi Protected Setup). Use a computer to enter a PIN code into the wireless router.

1. Select **Wi-Fi Setup** on the home screen.

   To select an item, use the ▲▼◄► buttons, and then press the OK button.

2. Select **Wi-Fi (Recommended)**.

3. Press the OK button to proceed.

4. Select **Others**.

5. Select **PIN Code (WPS)**.

6. Use your computer to enter the PIN code (an eight digit number) displayed on the printer's control panel into the wireless router within two minutes.

   **Note:**
   See the documentation provided with your wireless router for details on entering a PIN code.
7. Press the OK button on the printer.
   Setup is complete when the setup completion message is displayed.

   **Note:**
   If connection fails, restart the wireless router, move it closer to the printer, and try again. If it still does not work, print a connection report and check the solution.

**Related Information**

- “Checking the Network Connection Status” on page 34
- “When You Cannot Make Network Settings” on page 150

---

**Checking the Network Connection Status**

You can check the network connection status in the following way.

**Network Icon**

You can check the network connection status and strength of the radio wave using the network icon on the printer's home screen.

![Network Icon](image)

**Related Information**

- “Guide to the Home Screen” on page 16

---

**Printing a Network Connection Report**

You can print a network connection report to check the status between the printer and the wireless router.

1. Load papers.

2. Select **Settings** on the home screen, and then press the OK button.
   To select an item, use the ▲ ▼ ▶ ◀ buttons, and then press the OK button.

3. Select **Network Settings > Connection Check**.
   The connection check starts.

4. Press the ◈ button to print the network connection report.
   If an error has occurred, check the network connection report, and then follow the printed solutions.
Related Information

“Messages and Solutions on the Network Connection Report” on page 35

Messages and Solutions on the Network Connection Report

Check the messages and error codes on the network connection report, and then follow the solutions.

![Network Connection Report](image)

a. Error code

b. Messages on the Network Environment

Related Information

- “E-1” on page 36
- “E-2, E-3, E-7” on page 36
- “E-5” on page 37
- “E-6” on page 37
- “E-8” on page 37
- “E-9” on page 38
- “E-10” on page 38
- “E-11” on page 38
- “E-12” on page 39
Network Settings

▶ “E-13” on page 39
▶ “Message on the Network Environment” on page 40

E-1

Solutions:
- Make sure the Ethernet cable is securely connected to your printer and to your hub or other network device.
- Make sure your hub or other network device is turned on.
- If you want to connect the printer by Wi-Fi, make Wi-Fi settings for the printer again because it is disabled.

E-2, E-3, E-7

Solutions:
- Make sure your wireless router is turned on.
- Confirm that your computer or device is connected correctly to the wireless router.
- Turn off the wireless router. Wait for about 10 seconds, and then turn it on.
- Place the printer closer to your wireless router and remove any obstacles between them.
- If you have entered the SSID manually, check if it is correct. Check the SSID from the Network Status part on the network connection report.
- If an wireless router has multiple SSIDs, select the SSID that is displayed. When the SSID is using a non-compliant frequency, the printer does not display them.
- If you are using push button setup to establish a network connection, make sure your wireless router supports WPS. You cannot use push button setup if your wireless router does not support WPS.
- Makes sure your SSID uses only ASCII characters (alphanumeric characters and symbols). The printer cannot display an SSID that contains non-ASCII characters.
- Makes sure you know your SSID and password before connecting to the wireless router. If you are using a wireless router with its default settings, the SSID and password are located on a label on the wireless router. If you do not know your SSID and password, contact the person who set up the wireless router, or see the documentation provided with the wireless router.
- If you are connecting to an SSID generated from a tethering smart device, check for the SSID and password in the documentation provided with the smart device.
- If your Wi-Fi connection suddenly disconnects, check for the conditions below. If any of these conditions are applicable, reset your network settings by downloading and running the software from the following website. http://epson.sn > Setup
  - Another smart device was added to the network using push button setup.
  - The Wi-Fi network was set up using any method other than push button setup.

Related Information
▶ “Connecting to a Computer” on page 21
▶ ”Making Wi-Fi Settings from the Printer” on page 31
Solutions:
Make sure the wireless router's security type is set to one of the following. If it is not, change the security type on the wireless router, and then reset the printer's network settings.

- WEP-64 bit (40 bit)
- WEP-128 bit (104 bit)
- WPA PSK (TKIP/AES)*
- WPA2 PSK (TKIP/AES)*
- WPA (TKIP/AES)
- WPA2 (TKIP/AES)

* WPA PSK is also known as WPA Personal. WPA2 PSK is also known as WPA2 Personal.

Solutions:
Check if MAC address filtering is disabled. If it is enabled, register the printer's MAC address so that it is not filtered. See the documentation provided with the wireless router for details. You can check the printer's MAC address from the Network Status part on the network connection report.

- If your wireless router is using shared authentication with WEP security, make sure the authentication key and index are correct.

- If the number of connectable devices on the wireless router is less than the number of network devices that you want to connect, make settings on the wireless router to increase the number of connectable devices. See the documentation provided with the wireless router to make settings.

Related Information
- “Connecting to a Computer” on page 21

Solutions:
Enable DHCP on the wireless router if the printer's Obtain IP Address setting is set to Auto.

- If the printer's Obtain IP Address setting is set to Manual, the IP address you manually set is invalid due to out of range (for example: 0.0.0.0). Set a valid IP address from the printer's control panel or by using Web Config.

Related Information
- “Printing a Network Status Sheet” on page 40
Network Settings

E-9

Solutions:
Check the following.

- Devices are turned on.
- You can access the Internet and other computers or network devices on the same network from the devices you want to connect to the printer.

If still does not connect your printer and network devices after confirming the above, turn off the wireless router. Wait for about 10 seconds, and then turn it on. Then reset your network settings by downloading and running the installer from the following website.

http://epson.sn > Setup

Related Information
- “Connecting to a Computer” on page 21

E-10

Solutions:
Check the following.

- Other devices on the network are turned on.
- Network addresses (IP address, subnet mask, and default gateway) are correct if you have set the printer's Obtain IP Address to Manual.

Reset the network address if they are incorrect. You can check the IP address, subnet mask, and default gateway from the Network Status part on the network connection report.

If DHCP is enabled, change the printer's Obtain IP Address setting to Auto. If you want to set the IP address manually, check the printer's IP address from the Network Status part on the network connection report, and then select Manual on the network settings screen. Set the subnet mask to [255.255.255.0].

If still does not connect your printer and network devices, turn off the wireless router. Wait for about 10 seconds, and then turn it on.

Related Information
- “Printing a Network Status Sheet” on page 40

E-11

Solutions:
Check the following.

- The default gateway address is correct if you set the printer's TCP/IP Setup setting to Manual.
- The device that is set as the default gateway is turned on.

Set the correct default gateway address. You can check the default gateway address from the Network Status part on the network connection report.
Related Information
⇒ “Printing a Network Status Sheet” on page 40

E-12

Solutions:
Check the following.
☐ Other devices on the network are turned on.
☐ The network addresses (IP address, subnet mask, and default gateway) are correct if you are entering them manually.
☐ The network addresses for other devices (subnet mask and default gateway) are the same.
☐ The IP address does not conflict with other devices.

If still does not connect your printer and network devices after confirming the above, try the following.
☐ Turn off the wireless router. Wait for about 10 seconds, and then turn it on.
☐ Make network settings again using the installer. You can run it from the following website.
  http://epson.sn > Setup
☐ You can register several passwords on a wireless router that uses WEP security type. If several passwords are registered, check if the first registered password is set on the printer.

Related Information
⇒ “Printing a Network Status Sheet” on page 40
⇒ “Connecting to a Computer” on page 21

E-13

Solutions:
Check the following.
☐ Network devices such as a wireless router, hub, and router are turned on.
☐ The TCP/IP Setup for network devices has not been set up manually. (If the printer’s TCP/IP Setup is set automatically while the TCP/IP Setup for other network devices is performed manually, the printer’s network may differ from the network for other devices.)

If it still does not work after checking the above, try the following.
☐ Turn off the wireless router. Wait for about 10 seconds, and then turn it on.
☐ Make network settings on the computer that is on the same network as the printer using the installer. You can run it from the following website.
  http://epson.sn > Setup
☐ You can register several passwords on a wireless router that uses the WEP security type. If several passwords are registered, check if the first registered password is set on the printer.
Message on the Network Environment

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Wi-Fi environment needs to be improved. Turn the wireless router off and then turn it on. If the connection does not improve, see the documentation for the wireless router.</td>
<td>After moving the printer closer to the wireless router and removing any obstacles between them, turn off the wireless router. Wait for about 10 seconds, and then turn it on. If it still does not connect, see the documentation supplied with the wireless router.</td>
</tr>
<tr>
<td>*No more devices can be connected. Disconnect one of the connected devices if you want to add another one.</td>
<td>Computer and smart devices that can be connected simultaneously are connected in full in the Wi-Fi Direct (Simple AP) connection. To add another computer or smart device, disconnect one of the connected devices or connect it to the other network first. You can confirm the number of wireless devices which can be connected simultaneously and the number of connected devices by checking the network status sheet or the printer’s control panel.</td>
</tr>
<tr>
<td>The same SSID as Wi-Fi Direct exists in the environment. Change the Wi-Fi Direct SSID if you cannot connect a smart device to the printer.</td>
<td>On the printer’s control panel, go to Wi-Fi Direct Setup screen and select the menu to change the setting. You can change the network name following after DIRECT-XX-. Enter within 32 characters.</td>
</tr>
</tbody>
</table>

Printing a Network Status Sheet

You can check the detailed network information by printing it.

1. Load papers.

2. Select Settings on the home screen.
   - To select an item, use the ▲▼◄► buttons, and then press the OK button.


4. Press the ◇ button.
   - The network status sheet is printed.

Replacing or Adding New Wireless Routers

If the SSID changes due to the replacement of a wireless router, or a wireless router is added and a new network environment is established, re-set the Wi-Fi settings.
Related Information

➡ “Changing the Connection Method to a Computer” on page 41

Changing the Connection Method to a Computer

Using the installer and re-set up in a different connection method.

- Setting up from the website
  Access the following website, and then enter the product name. Go to Setup, and then start setting up.
  http://epson.sn

- Setting up using the software disc (only for the models that come with a software disc and users with Windows computers with disc drives.)
  Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting Change the Connection Methods

Follow the on-screen instructions until the following screen is displayed.

Select Set up Printer connection again (for new network router or changing USB to network, etc.) on the Install Software screen, and then click Next.

Changing the Wi-Fi Direct (Simple AP) Settings

When a Wi-Fi Direct (Simple AP) connection is enabled, you can change the Wi-Fi Direct settings such as the network name and the password.
1. Select **Wi-Fi Setup** on the home screen.
   To select an item, use the ▲▼◄► buttons, and then press the OK button.

2. Select **Wi-Fi Direct**.

3. Press the OK button to proceed.

4. Press the OK button to proceed.

5. Press the ▼ button to display the setting screen.

6. Select the menu item that you want to change.
   You can select the following menu items.

   - **Change Network Name**
     Change the Wi-Fi Direct (simple AP) network name (SSID) used for connecting to the printer to your arbitrary name. You can set the network name (SSID) in ASCII characters that is displayed on the software keyboard on the control panel.
     When changing the network name (SSID), all connected devices are disconnected. Use the new network name (SSID) if you want to re-connect the device.

   - **Change Password**
     Change the Wi-Fi Direct (simple AP) password for connecting to the printer to your arbitrary value. You can set the password in ASCII characters that is displayed on the software keyboard on the control panel.
     When changing the password, all connected devices are disconnected. Use the new password if you want to re-connect the device.

   - **Disable Wi-Fi Direct**
     Disable Wi-Fi Direct (simple AP) settings of the printer. When disabling it, all devices connected to the printer in Wi-Fi Direct (Simple AP) connection are disconnected.

   - **Restore Default Settings**
     Restore all Wi-Fi Direct (simple AP) settings to their defaults.
     The Wi-Fi Direct (simple AP) connection information of the smart device saved to the printer is deleted.

7. Follow the on-screen instruction.

---

**Disabling Wi-Fi from the Control Panel**

When Wi-Fi is disabled, the Wi-Fi connection is disconnected.

1. Select **Wi-Fi Setup** on the home screen.
   To select an item, use the ▲▼◄► buttons, and then press the OK button.

2. Select **Wi-Fi (Recommended)**.

3. Press the OK button to proceed.

4. Select **Others**.

5. Select **Disable Wi-Fi**.
6. Check the message, and then press the OK button.

---

**Disconnecting Wi-Fi Direct (Simple AP) Connection from the Control Panel**

There are two methods available to disable a Wi-Fi Direct (Simple AP) connection; you can disable all connections by using the printer’s control panel, or disable each connection from the computer or the smart device. This section explains how to disable all connections.

**Important:**
When Wi-Fi Direct (Simple AP) connection disabled, all computers and smart devices connected to the printer in Wi-Fi Direct (Simple AP) connection are disconnected.

**Note:**
If you want to disconnect a specific device, disconnect from the device instead of the printer. Use one of the following methods to disconnect the Wi-Fi Direct (Simple AP) connection from the device.

- Disconnect the Wi-Fi connection to the printer’s network name (SSID).
- Connect to another network name (SSID).

1. Select **Wi-Fi Setup** on the home screen.
   - To select an item, use the ▲ ▼ ▶ ► buttons, and then press the OK button.
2. Select **Wi-Fi Direct**.
3. Press the OK button to proceed.
4. Press the OK button to proceed.
5. Press the ▼ button to display the setting screen.
6. Select **Disable Wi-Fi Direct**.
7. Check the message, and then press the OK button.

---

**Restoring the Network Settings from the Control Panel**

You can restore all network settings to their defaults.

1. Select **Settings** on the home screen.
   - To select an item, use the ▲ ▼ ▶ ► buttons, and then press the OK button.
2. Select **Restore Default Settings** > **Network Settings**.
3. Check the message, and then press the OK button.
Paper Handling Precautions

- Read the instruction sheets supplied with the paper.
- Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the printable side.

- If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may cause paper jams and smears on the printout.

- Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it. Using these types of paper causes paper jams and smears on the printout.
- Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air, press them down to flatten them before loading.

- Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the printout.
- Do not use envelopes with adhesive surfaces on the flaps or window envelopes.
- Avoid using envelopes that are too thin, as they may curl during printing.

Related Information

- “Printer Specifications” on page 168
Available Paper and Capacities

Note:
The paper size displayed differs depending on the driver.

Genuine Epson Paper

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Note:
The availability of paper varies by location. For the latest information on paper available in your area, contact Epson support.

Paper suitable for printing documents

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Size</th>
<th>Loading Capacity (Sheets)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Ink Jet Paper</td>
<td>A4</td>
<td>Up to the line indicated by the triangle symbol on the edge guide.</td>
</tr>
</tbody>
</table>

Paper suitable for printing documents and photos

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Size</th>
<th>Loading Capacity (Sheets)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Matte Paper-Heavyweight</td>
<td>A4</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>A4</td>
<td>80</td>
</tr>
</tbody>
</table>

Paper suitable for printing photos

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Size</th>
<th>Loading Capacity (Sheets)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Glossy Photo Paper</td>
<td>A4, 13×18 cm (5×7 in.), 10×15 cm (4×6 in.)</td>
<td>20*</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>A4, 13×18 cm (5×7 in.), 10×15 cm (4×6 in.)</td>
<td>20*</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>A4, 13×18 cm (5×7 in.), 10×15 cm (4×6 in.)</td>
<td>20*</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>A4, 13×18 cm (5×7 in.), 10×15 cm (4×6 in.)</td>
<td>20*</td>
</tr>
</tbody>
</table>

* Load one sheet of paper at a time if the paper does not feed correctly or if the printout has uneven colors or smears.

Related Information

» “Paper for Borderless Printing” on page 46
» “Paper for 2-Sided Printing” on page 47
Commercially Available Paper

Plain papers

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Size</th>
<th>Loading Capacity (Sheets)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter, A4, B5, 16K (195×270 mm), A5, A6, B6</td>
<td>Up to the line indicated by the triangle symbol on the edge guide.*1</td>
</tr>
<tr>
<td>Copy paper</td>
<td>Legal, 8.5×13 in., Indian-Legal</td>
<td>1</td>
</tr>
<tr>
<td>Letterhead*2</td>
<td>User Defined (mm)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>54×86 to 215.9×1200</td>
<td></td>
</tr>
</tbody>
</table>

*1 Load one sheet of paper at a time if the paper does not feed correctly or if the printout has uneven colors or smears.

*2 Paper on which information such as the sender's name or corporation name are pre-printed in the header. There must be a margin of 3 mm or more at the top of the paper. 2-sided printing and borderless printing are not available for letterhead paper.

Envelopes

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Size</th>
<th>Loading Capacity (Envelopes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope</td>
<td>Envelope #10, Envelope DL, Envelope C6</td>
<td>10</td>
</tr>
</tbody>
</table>

Related Information

⇒ “Paper for Borderless Printing” on page 46
⇒ “Paper for 2-Sided Printing” on page 47

Paper for Borderless Printing

Genuine Epson Paper

- Epson Bright White Ink Jet Paper
- Epson Photo Quality Ink Jet Paper
- Epson Matte Paper-Heavyweight
- Epson Ultra Glossy Photo Paper
- Epson Premium Glossy Photo Paper
- Epson Premium Semigloss Photo Paper
- Epson Photo Paper Glossy

Commercially Available Paper

Plain paper, Copy paper (A4, Letter, User Defined*)

* For borderless printing, 89×86 to 215.9×1200 mm size paper is available.
Paper for 2-Sided Printing

Genuine Epson Paper
Epson Bright White Ink Jet Paper

Commercially Available Paper
Plain paper, Copy paper*
* For automatic 2-sided printing, you can use Letter, A4, B5, 16K, and User Defined (182 x 257 to 215.9 x 297 mm) paper sizes.

List of Paper Type
To obtain optimum printing results, select the paper type that suits the paper.

<table>
<thead>
<tr>
<th>Media Name</th>
<th>Media Type</th>
<th>Control Panel</th>
<th>Printer Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Ink Jet Paper</td>
<td>Plain paper</td>
<td></td>
<td>Plain paper</td>
</tr>
<tr>
<td>Epson Ultra Glossy Photo Paper</td>
<td>Ultra Glossy</td>
<td></td>
<td>Epson Ultra Glossy</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Prem. Glossy</td>
<td></td>
<td>Epson Premium Glossy</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Prem. Semigloss</td>
<td></td>
<td>Epson Premium Semigloss</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
<td></td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Matte Paper-Heavyweight</td>
<td>Matte</td>
<td></td>
<td>Epson Matte</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Photo Quality Ink Jet</td>
<td></td>
<td>Epson Photo Quality Ink Jet</td>
</tr>
</tbody>
</table>

Loading Paper in the Rear Paper Feed

1. Open the feeder guard and pull out the paper support.
2. Slide the edge guides.

3. Load paper at the center of the paper support with the printable side facing up.

**Important:**
- Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load above the line just under the ▼ symbol inside the edge guide.
- Load paper short edge first. However, when you have set the long edge as the width of the user defined size, load paper long edge first.

- **Envelope**
  Load envelopes with the flap on the left side.

- **Long Papers**
  When loading paper longer than legal size, store the paper support, and then flatten the leading edge of the paper.
Loading Paper

- Pre-punched paper

Note:
- Load a single sheet of defined size plain paper with binding holes at the left or right.
- Adjust the print position of your file to avoid printing over the holes.
- Automatic 2-sided printing is not available for pre-punched paper.

4. Slide the edge guides to the edges of the paper, and then close the feeder guard.

Important:
Do not place objects on the feeder guard. Doing so may prevent paper from feeding.

5. On the control panel, set the size and type of the paper you loaded in the rear paper feed.

To select an item, use the ▲▼► buttons, and then press the OK button.

Note:
- You can also display the paper size and paper type settings screen by selecting Settings > Printer Setup > Paper Source Settings > Paper Setup.
- For letterhead paper, select Letterhead as the paper type.
- For letterhead paper, if you print on paper that is smaller than the setting in the printer driver, the printer may print beyond the edges of the paper which can lead to ink smears on your printouts and excess ink building up inside the printer. Make sure you select the correct paper size setting.
- 2-sided printing and borderless printing are not available for letterhead paper. Also, the print speed may be slower.
6. Slide out the output tray.

Note:
Return the remaining paper to its package. If you leave it in the printer, the paper may curl or the print quality may decline.

Related Information
➤ “Paper Handling Precautions” on page 44
➤ “Available Paper and Capacities” on page 45
Placing Originals

Placing Originals on the Scanner Glass

**Important:**
When placing bulky originals such as books, prevent exterior light from shining directly onto the scanner glass.

1. Open the document cover.

2. Remove any dust or stains on the surface of the scanner glass using a soft, dry, clean cloth.

   **Note:**
   If there is any trash or dirt on the scanner glass, the scanning range may expand to include it, so the image of the original may be displaced or reduced.

3. Place the original face-down and slide it to the corner mark.

   **Note:**
   A range of 1.5 mm from the corner of the scanner glass is not scanned.
4. Close the cover gently.

- **Important:**
  Do not apply too much force to the scanner glass or the document cover. Otherwise, they may be damaged.

5. Remove the originals after scanning.

- **Note:**
  If you leave the originals on the scanner glass for a long time, they may stick to the surface of the glass.

**How to Place Various Originals**

**Placing Originals for 2-Up Layout**

1. Place the original in the scanner glass with the top edge towards the left.
2. Place the second original in the scanner glass with the top edge towards the right and the second original on top of the first one.

Arrangement 1:  

1. 2

Arrangement 2:  

1 2
**Placing Originals**

**Placing a Double-Page Spread for 2-Up Layout**

![Diagram of double-page spread]

**Placing an ID Card for Copying**

Place an ID card 5 mm away from the corner mark of the scanner glass.

![Diagram of ID card placement]

**Placing Multiple Photos for Scanning at the Same Time**

You can scan multiple photos at the same time and save each image, using **Photo Mode** in Epson Scan 2. Place the photos 4.5 mm away from the horizontal and vertical edges of the scanner glass, and place them at least 20 mm apart from each other. The photos should be larger than 15×15 mm.
Placing Originals

Note:
Enable the Thumbnail check box at the top of the preview window.
Printing

Printing from the Control Panel

Printing Lined Paper and Calendars

You can easily print lined paper and calendars using the Personal Stationery menu.

1. Load paper in the printer.
2. Select Personal Stationery on the home screen.
   To select an item, use the ▲▼◄► buttons, and then press the OK button.
3. Select a menu item.
4. Follow the on-screen instructions to print.

Related Information

➤ “Loading Paper in the Rear Paper Feed” on page 47
➤ “List of Paper Type” on page 47

Printing from a Computer

Printing Basics - Windows

Note:

☐ See the online help for explanations of the setting items. Right-click an item, and then click Help.
☐ Operations differ depending on the application. See the application’s help for details.
Printing

1. Load paper in the printer.
2. Open the file you want to print.
3. Select Print or Print Setup from the File menu.
4. Select your printer.
5. Select Preferences or Properties to access the printer driver window.

6. Make the following settings.
   - Document Size: Select the paper size you loaded in the printer.
   - Borderless: Select to print with no margins around the image.
     In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are printed around the edges of the paper. Click Settings to select the amount of enlargement.
   - Orientation: Select the orientation you set in the application.
   - Paper Type: Select the type of paper you loaded.
   - Quality: Select the print quality.
     Selecting High provides higher quality printing, but the printing speed may be slower.
   - Color: Select Grayscale when you want to print in black or shades of gray.

   **Note:**
   When printing on envelopes, select Landscape as the Orientation setting.

7. Click OK to close the printer driver window.
8. Click Print.

Related Information

⇒ “Available Paper and Capacities” on page 45
Printing Basics - Mac OS

Note:
Explanations in the section use TextEdit as an example. Operations and screens differ depending on the application. See the application’s help for details.

1. Load paper in the printer.

2. Open the file you want to print.

3. Select Print from the File menu or another command to access the print dialog.
   If necessary, click Show Details or ▼ to expand the print window.

4. Make the following settings.
   - Printer: Select your printer.
   - Presets: Select when you want to use the registered settings.
   - Paper Size: Select the paper size you loaded in the printer.
     When printing with no margins, select a "borderless" paper size.
   - Orientation: Select the orientation you set in the application.

Note:
- If the above setting menus are not displayed, close the print window, select Page Setup from the File menu, and then make settings.
- When printing on envelopes, select landscape orientation.
5. Select **Print Settings** from the pop-up menu.

![Print Settings](image)

**Note:**
On OS X Mountain Lion or later, if the **Print Settings** menu is not displayed, the Epson printer driver has not been installed correctly.

Select **System Preferences** from the menu > **Printers & Scanners** (or **Print & Scan, Print & Fax**), remove the printer, and then add the printer again. See the following to add a printer.

[http://epson.sn](http://epson.sn)

6. Make the following settings.

- **Media Type**: Select the type of paper you loaded.
- **Print Quality**: Select the print quality.
  - Selecting **Fine** provides higher quality printing, but the printing speed may be slower.
- **Expansion**: Available when selecting a borderless paper size.
  - In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are printed around the edges of the paper. Select the amount of enlargement.
- **Grayscale**: Select to print in black or shades of gray.

7. Click **Print**.

**Related Information**

- “Available Paper and Capacities” on page 45
- “Loading Paper in the Rear Paper Feed” on page 47
Printing on 2-Sides

You can use either of the following methods to print on both sides of the paper.

- Automatic 2-sided printing
- Manual 2-sided printing (for Windows only)
  
  When the printer has finished printing the first side, flip the paper over to print on the other side.

You can also print a booklet that can be created by folding the printout. (For Windows only)

**Note:**

- This feature is not available for borderless printing.
- If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.
- Depending on the paper and the data, ink may bleed through to the other side of the paper.

**Related Information**

- “Available Paper and Capacities” on page 45

Printing on 2-Sides - Windows

**Note:**

- Manual 2-sided printing is available when **EPSON Status Monitor 3** is enabled. If **EPSON Status Monitor 3** is disabled, access the printer driver, click **Extended Settings** on the **Maintenance** tab, and then select **Enable EPSON Status Monitor 3**.
- Manual 2-sided printing may not be available when the printer is accessed over a network or is used as a shared printer.

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the printer driver window.
4. Select Auto (Long-edge binding), Auto (Short-edge binding), Manual (Long-edge binding), or Manual (Short-edge binding) from 2-Sided Printing on the Main tab.

5. Click Settings, make the appropriate settings, and then click OK.

   Note: To print a folded booklet, select Booklet.

6. Click Print Density, select the document type from Select Document Type, and then click OK.

   The printer driver automatically sets the Adjustments options for that document type.

   Note:
   - Printing may be slow depending on the combination of options selected for Select Document Type in the Print Density Adjustment window and for Quality on the Main tab.
   - For manual 2-sided printing, the Print Density Adjustment setting is not available.

7. Set the other items on the Main and More Options tabs as necessary, and then click OK.

8. Click Print.

   For manual 2-sided printing, when the first side has finished printing, a pop-up window is displayed on the computer. Follow the on-screen instructions.

Related Information

» “Loading Paper in the Rear Paper Feed” on page 47
» “Printing Basics - Windows” on page 55

Printing on 2-Sides - Mac OS

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the print dialog.

4. Select Two-sided Printing Settings from the pop-up menu.

5. Select the bindings in Two-sided Printing.

6. Select the type of original in Document Type.

   Note:
   - Printing may be slow depending on the Document Type setting.
   - If you are printing high-density data such as photos or graphs, select Text with Photo or Photo as the Document Type setting. If scuffing occurs or the image bleeds through to the reverse side, adjust the print density and ink drying time by clicking the arrow mark next to Adjustments.

7. Set the other items as necessary.

8. Click Print.
Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.

Printing Several Pages on One Sheet - Windows

Note:
This feature is not available for borderless printing.

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the printer driver window.
4. Select 2-Up or 4-Up as the Multi-Page setting on the Main tab.
5. Click Page Order, make the appropriate settings, and then click OK to close the window.
6. Set the other items on the Main and More Options tabs as necessary, and then click OK.
7. Click Print.

Related Information

⇒ “Loading Paper in the Rear Paper Feed” on page 47
⇒ “Printing Basics - Mac OS” on page 57

⇒ “Loading Paper in the Rear Paper Feed” on page 47
⇒ “Printing Basics - Windows” on page 55
Printing Several Pages on One Sheet - Mac OS

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the print dialog.
4. Select Layout from the pop-up menu.
5. Set the number of pages in Pages per Sheet, the Layout Direction (page order), and Border.
6. Set the other items as necessary.
7. Click Print.

Related Information
- “Loading Paper in the Rear Paper Feed” on page 47
- “Printing Basics - Mac OS” on page 57

Printing to Fit the Paper Size

You can print to fit the paper size you loaded in the printer.

Printing to Fit the Paper Size - Windows

Note:
This feature is not available for borderless printing.

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the printer driver window.
4. Make the following settings on the More Options tab.
   - Document Size: Select the paper size you set in the application.
Output Paper: Select the paper size you loaded in the printer. 

Fit to Page is selected automatically.

Note: 
If you want to print a reduced image at the center of the page, select Center.

5. Set the other items on the Main and More Options tabs as necessary, and then click OK.

6. Click Print.

Related Information
⇒ “Loading Paper in the Rear Paper Feed” on page 47
⇒ “Printing Basics - Windows” on page 55

Printing to Fit the Paper Size - Mac OS

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the print dialog.

4. Select the size of the paper you set in the application as the Paper Size setting.

5. Select Paper Handling from the pop-up menu.

6. Select Scale to fit paper size.

7. Select the paper size you loaded in the printer as the Destination Paper Size setting.

8. Set the other items as necessary.

9. Click Print.

Related Information
⇒ “Loading Paper in the Rear Paper Feed” on page 47
⇒ “Printing Basics - Mac OS” on page 57
Printing Multiple Files Together (for Windows Only)

Job Arranger Lite allows you to combine several files created by different applications and print them as a single print job. You can specify the print settings for combined files, such as layout, print order, and orientation.

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select Job Arranger Lite on the Main tab.

5. Click OK to close the printer driver window.

6. Click Print.

   The Job Arranger Lite window is displayed and the print job is added to the Print Project.

7. With the Job Arranger Lite window opened, open the file that you want to combine with the current file, and then repeat steps 3 to 6.

   Note:
   - If you close the Job Arranger Lite window, the unsaved Print Project is deleted. To print later, select Save from the File menu.
   - To open a Print Project saved in Job Arranger Lite, click Job Arranger Lite on the printer driver’s Maintenance tab. Next, select Open from the File menu to select the file. The extension of the saved files is "ecl".

8. Select the Layout and Edit menus in Job Arranger Lite to edit the Print Project as necessary. See the help of Job Arranger Lite for details.

9. Select Print from the File menu.

Related Information
- “Loading Paper in the Rear Paper Feed” on page 47
- “Printing Basics - Windows” on page 55
Printing One Image on Multiple Sheets to Create a Poster (for Windows Only)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping them together.

Note: This feature is not available for borderless printing.

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the printer driver window.
4. Select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster from Multi-Page on the Main tab.
5. Click Settings, make the appropriate settings, and then click OK.
   Note: Print Cutting Guides allows you to print a cutting guide.
6. Set the other items on the Main and More Options tabs as necessary, and then click OK.
7. Click Print.

Related Information
➤ “Loading Paper in the Rear Paper Feed” on page 47
➤ “Printing Basics - Windows” on page 55
Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is selected in Print Cutting Guides.

1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of the top and bottom cross marks.
2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets together from the back.

3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the left of the cross marks).
4. Tape the sheets together from the back.

5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.

6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right side cross marks.
7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then temporarily tape them together from the back.
8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line above the cross marks).

9. Tape the sheets together from the back.
10. Cut off the remaining margins along the outer guide.

Printing Using Advanced Features

This section introduces a variety of additional layout and printing features available on the printer driver.

Related Information

- "Windows Printer Driver" on page 127
- "Mac OS Printer Driver" on page 130

Adding a Printing Preset to Print Easily

If you create your own preset of frequently used print settings on the printer driver, you can print easily by selecting the preset from the list.
Printing

Windows
To add your own preset, set items such as the Document Size and Paper Type on the Main or More Options tab, and then click Add/Remove Presets in Printing Presets.

Note:
To delete an added preset, click Add/Remove Presets, select the preset name you want to delete from the list, and then delete it.

Mac OS
Access the print dialog. To add your own preset, set items such as the Paper Size and Media Type, and then save the current settings as the preset in the Presets setting.

Note:
To delete an added preset, click Presets > Show Presets, select the preset name you want to delete from the list, and then delete it.

Printing a Reduced or Enlarged Document
You can reduce or enlarge the size of a document by a specific percentage.

Windows
Note:
This feature is not available for borderless printing.

Set the Document Size on the More Options tab. Select Reduce/Enlarge Document, Zoom to, and then enter a percentage.

Mac OS
Note:
Operations differ depending on the application. See the application's help for details.

Select Page Setup (or Print) from the File menu. Select the printer from Format For, select the paper size, and then enter a percentage in Scale. Close the window, and then print following the basic printing instructions.

Adjusting the Print Color
You can adjust the colors used in the print job. These adjustments are not applied to the original data.

PhotoEnhance produces sharper images and more vivid colors by automatically adjusting the contrast, saturation, and brightness of the original image data.

Note:
PhotoEnhance adjusts the color by analyzing the location of the subject. Therefore, if you have changed the location of the subject by reducing, enlarging, cropping, or rotating the image, the color may change unexpectedly. Selecting the borderless setting also changes the location of the subject resulting in changes in color. If the image is out of focus, the tone may be unnatural. If the color is changed or becomes unnatural, print in a mode other than PhotoEnhance.

Windows
Select the method of color correction from Color Correction on the More Options tab.

If you select Automatic, the colors are automatically adjusted to match the paper type and print quality settings. If you select Custom and click Advanced, you can make your own settings.
Mac OS
Access the print dialog. Select Color Matching from the pop-up menu, and then select EPSON Color Controls. Select Color Options from the pop-up menu, and then select one of the available options. Click the arrow next to Advanced Settings and make the appropriate settings.

Printing a Watermark (for Windows Only)
You can print a watermark such as "Confidential" on your printouts. You can also add your own watermark.

![Confidential watermark]

*Note:* This feature is not available with borderless printing.

Click Watermark Features on the More Options tab, and then select a watermark. Click Settings to change details such as the density and position of the watermark.

Printing a Header and Footer (for Windows Only)
You can print information such as a user name and printing date as headers or footers.

Click Watermark Features in the More Options tab, and then select Header/Footer. Click Settings and select necessary items from the drop-down list.

Printing Clear Bar Codes (for Windows Only)
You can print a bar code clearly and make it easy to scan. Only enable this feature if the bar code you printed cannot be scanned.

![Bar code]

You can use this feature under the following conditions.
- Paper: Plain paper, Copy paper, Letterhead, or Envelope
- Quality: Standard
  The print quality may be changed when printing. The print speed may become slower and print density may become higher.
Note:
Deblurring may not always be possible depending on the circumstances.

On the printer driver’s Maintenance tab, click Extended Settings, and then select Barcode mode.

Printing from Smart Devices

Using Epson iPrint

Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote print, register your printer in the Epson Connect service.

If you start Epson iPrint when the printer is not connected to the network, a message is displayed instructing you to connect to the printer. Follow the instructions to complete the connection. See the URL below for the operating conditions.

http://epson.sn

Related Information

>). “Epson Connect Service” on page 125

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Printing Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.
The following screens are subject to change without notice. The contents may vary depending on the product.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Home screen displayed when the application is started.</td>
</tr>
<tr>
<td>2</td>
<td>Displays information on how to setup the printer and a FAQ.</td>
</tr>
<tr>
<td>3</td>
<td>Displays the screen where you can select the printer and make printer settings. Once you have selected the printer, you do not need to select it again from the next time.</td>
</tr>
<tr>
<td>4</td>
<td>Select what you want to print such as photos and documents.</td>
</tr>
<tr>
<td>5</td>
<td>The print photos screen displayed when the photo menu is selected.</td>
</tr>
<tr>
<td>6</td>
<td>Displays the screen to make print settings such as paper size and paper type.</td>
</tr>
<tr>
<td>7</td>
<td>Displays the paper size. When this is displayed as a button, tap it to display the paper settings currently set on the printer.</td>
</tr>
<tr>
<td>8</td>
<td>Displays photos and documents you selected.</td>
</tr>
<tr>
<td>9</td>
<td>Starts printing.</td>
</tr>
</tbody>
</table>

**Note:**
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the document you want to print using the file sharing function in iTunes.

### Using Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet (Android v4.4 or later). With a few taps, your Android device will discover an Epson printer that is connected to the same wireless network.

**Note:**
Operations may differ depending on the device.

1. Load paper in the printer.
2. Set up your printer for wireless printing.

3. On your Android device, install the Epson Print Enabler plug-in from Google Play.

4. Connect your Android device to the same wireless network as your printer.

5. Go to **Settings** on your Android device, select **Connected devices > Printing**, and then enable Epson Print Enabler.

6. From an Android application such as Chrome, tap the menu icon and print whatever is on the screen.

   **Note:**
   *If you do not see your printer, tap All Printers and select your printer.*

### Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and Mac with the latest version of OS X or macOS.

![AirPrint](image)

**Note:**
*If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to enable the messages, if necessary.*

1. Load paper in your product.

2. Set up your product for wireless printing. See the link below.

   [http://epson.sn](http://epson.sn)

3. Connect your Apple device to the same wireless network that your product is using.

4. Print from your device to your product.

   **Note:**
   *For details, see the AirPrint page on the Apple website.*

### Related Information

⇒ “Menu Options for Printer Setup” on page 120
Canceling Printing

Note:
❏ In Windows, you cannot cancel a print job from the computer once it has been completely sent to the printer. In this case, cancel the print job by using the printer’s control panel.
❏ When printing several pages from Mac OS, you cannot cancel all of the jobs by using the control panel. In this case, cancel the print job from the computer.
❏ If you have sent a print job from Mac OS X v10.6.8 through the network, you may not be able to cancel printing from the computer. In this case, cancel the print job by using the printer’s control panel.

Canceling Printing - Control Panel

Press the button on the printer’s control panel to cancel the print job in progress.

Canceling Printing - Windows

1. Access the printer driver window.
2. Select the Maintenance tab.
3. Click Print Queue.
4. Right-click on the job you want to cancel and then select Cancel.

Related Information
⇒ “Windows Printer Driver” on page 127

Canceling Printing - Mac OS

1. Click the printer icon in the Dock.
2. Select the job you want to cancel.
3. Cancel the job.
   ❏ OS X Mountain Lion or later
      Click next to the progress meter.
   ❏ Mac OS X v10.6.8 to v10.7.x
      Click Delete.
Copying

Copying Basics

1. Load paper in the printer.

2. Place the originals.

3. Enter Copy from the home screen using the ← or → button, and then press the OK button.

4. Set the number of copies using the ↑ or ↓ button.

5. Select color copy or monochrome copy using the ← or → button, and then press the OK button.

6. Select Print Settings using the ← or → button, and then press the OK button. To change the settings, press the ↓ button, select the setting items using the ↑ or ↓ button, and then change the settings using the ← or → button. When you have finished, press the OK button.

   Note:
   If you want to copy by reducing or enlarging the size of a document by a specific percentage, select Custom Size as the Reduce/Enlarge setting, press the ↓ button, and then press the ← or → button to specify a percentage. You can change the percentage in increments of 10% by holding down the ← or → button.

7. Press the ◎ button.

   Note:
   The color, size, and border of the copied image are slightly different from the original.

Related Information

⇒ “Loading Paper” on page 44
⇒ “Placing Originals” on page 51
⇒ “Menu Options for Copying” on page 79

Copying in Various Layout

You can copy easily by selecting a menu for your purpose such as copying two facing pages of a book onto a single sheet of paper.

1. Load paper in the printer.

2. Enter Copy from the home screen using the ← or → button, and then press the OK button.

3. Press the OK button to proceed to copy menu.
4. Select a copy menu using the \( \downarrow \) or \( \uparrow \) button, and then press the OK button.
   - **ID Card Copy**
     Scans both sides of an ID card and copies onto one side of A4 size paper.
   - **Book copy**
     Copies two A4 facing pages of a book and so on onto a single sheet of paper.
   - **Borderless Copy**
     Copies without margins around the edges. The image is enlarged a little to remove margins from the edges of the paper.

5. Place the originals.
   - For **Book copy**, you still need not place the original. Skip this procedure.

6. Set the number of copies using the \( \uparrow \) or \( \downarrow \) button.

7. Select color copy or monochrome copy using the \( \downarrow \) or \( \uparrow \) button, and then press the OK button.

8. Check the copy settings.
   - To change the settings, press the \( \downarrow \) button, select the setting items using the \( \uparrow \) or \( \downarrow \) button, and then change the settings using the \( \leftarrow \) or \( \rightarrow \) button. When you have finished, press the OK button.

   **Note:**
   *Available items vary depending on the copy menu.*

9. Press the \( \Box \) button.

   **Note:**
   *The color, size, and border of the copied image are slightly different from the original.*

10. For **Book copy**, follow the on-screen instructions to copy the page of the originals.

---

**Menu Options for Copying**

**Note:**
*Available menus vary depending on the layout you selected.*

**The number of copies:**
- Enter the number of copies.

**Color:**
- Copies the original in color.

**B&W:**
- Copies the original in black and white (monochrome).

**2-Sided:**
- **1→1-Sided**
  - Copies one side of an original onto a single side of paper.
1→2-Sided
Copies two single-sided originals onto both sides of a single sheet of paper.

Density:
Increase the level of density by pressing the ▶ button when the copying results are faint. Decrease the level of density by pressing the ◀ button when ink smears.

Reduce/Enlarge:
Enlarges or reduces the originals.
- Actual Size
  Copies at 100% magnification.
- Auto Fit
  Detects the scan area and automatically enlarges or reduces the original to fit to the paper size you selected. When there are white margins around the original, the white margins from the corner mark of the scanner glass are detected as the scan area, but the margins at the opposite side may be cropped.

Custom
Select to specify the magnification to enlarge or reduce the original.

Custom Size:
Specifies the magnification used to enlarge or reduce the original within a range of 25 to 400%.

Paper Setting:
Set the size and type of the paper you loaded in the printer.

Multi-Page:
- Single Page
  Copies a single-sided original onto a single sheet.
- 2-up
  Copies two single-sided originals onto a single sheet in 2-up layout. Select the layout order and the orientation of your original.
Copying

Quality:
Select the print quality. Selecting **Best** provides higher quality printing, but the printing speed may be slower.
For users in Western Europe, the draft mode is not available.

Expansion:
With borderless copying, the image is enlarged a little to remove borders from the edges of the paper. Select how much to enlarge the image.
Scanning

Scanning Using the Control Panel

Scanning to a Computer

You can save the scanned image to a computer.

Important:
Make sure you have installed Epson Scan 2 and Epson Event Manager on your computer before using this feature.

1. Place the originals.

2. Enter Scan from the home screen using the ◀ or ▶ button, and then press the OK button.

3. Select how to save the scanned image to a computer from the following menus using the ◀ or ▶ button, and then press the OK button.
   - To Computer (JPEG): Saves the scanned image in JPEG format.
   - To Computer (PDF): Saves the scanned image in PDF format.
   - To Computer (Email): Starts the email client on your computer, and then automatically attaches it to an email.
   - To Computer (Custom): Saves the scanned image using the settings on the Epson Event Manager. You can change the scan settings such as the scanning size, folder to save to, or save format.

4. Select the computer to which you want to save the scanned images.

   Note:
   - You can change the scan settings such as the scanning size, folder to save, or save format, by using Epson Event Manager.
   - When the printer is connected to a network, you can select the computer to which you want to save the scanned image. Up to 20 computers can be displayed on the printer's control panel.
   - When the computer to which you want to save the scanned images is detected on the network, the initial 15 characters of the computer name are displayed on the control panel. If you set Network Scan Name (Alphanumeric) on Epson Event Manager, it is displayed on the control panel.

5. Press the ◀ button.

   Note:
   The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information

▶ "Placing Originals" on page 51
Making Custom Settings in Epson Event Manager

You can set the scan settings for To Computer (Custom) in Epson Event Manager. See the Epson Event Manager help for details.

1. Start Epson Event Manager.

2. Make sure that your scanner is selected as the Scanner on the Button Settings tab on the main screen.
3. Click **Make Job Settings**.
4. Make scan settings on the **Job Settings** screen.

- Edit Job Settings: Select **Custom Action**.
- Setting: Scan using the best settings for the selected type of original. Click **Detailed Settings for Scanning** to set the items such as the resolution or the color for saving the scanned image.
- Target Folder: Select the save folder for the scanned image.
- Filename (Prefix + Start Number): Change the settings for the file name you want to save.
- File Format: Select the save format.
- Launch Action: Select the action when scanning.
- Test Settings: Starts test scanning using current settings.

5. Click **OK** to return to the main screen.
6. Make sure that the **Custom Action** is selected on the **Custom Action** list.

![Epson Event Manager](image)

7. Click **Close** to close Epson Event Manager.

**Scanning Using WSD**

**Note:**
- This feature is only available for computers running English version of Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista.
- If you are using Windows 7/Windows Vista, you need to setup your computer in advance using this feature.

1. Place the originals.

2. Enter **Scan** from the home screen using the ◀ or ▶ button, and then press the OK button.

3. Select **To WSD** using the ◀ or ▶ button, and then press the OK button.

4. Select a computer.

5. Press the ◀ button.

**Note:**
The color, size, and border of the scanned image will not be exactly the same as the original.

**Related Information**

◆ “Placing Originals” on page 51
Setting Up a WSD Port

This section explains how to set up a WSD port for Windows 7/Windows Vista.

Note:
For Windows 10/Windows 8.1/Windows 8, the WSD port is set up automatically.

The following is necessary to set up a WSD port.
- The printer and the computer are connected to the network.
- The printer driver is installed on the computer.

1. Turn the printer on.
2. Click start, and then click Network on the computer.
3. Right-click the printer, and then click Install.
   Click Continue when the User Account Control screen is displayed.
   Click Uninstall and start again if the Uninstall screen is displayed.

Note:
The printer name you set on the network and model name (EPSON XXXXXX (XX-XXXX)) are displayed on the network screen. You can check the printer’s name set on the network from the printer's control panel or by printing a network status sheet.
Scanning

4. Click **Your device is ready to use**.

5. Check the message, and then click **Close**.

6. Open the **Devices and Printers** screen.
   - **Windows 7**
     - Click start > **Control Panel** > **Hardware and Sound** (or **Hardware**) > **Devices and Printers**.
   - **Windows Vista**
     - Click start > **Control Panel** > **Hardware and Sound** > **Printers**.

7. Check that an icon with the printer’s name on the network is displayed.
   - Select the printer name when using with WSD.

---

**Scanning from a Computer**

**Scanning Using Epson Scan 2**

You can scan by using the scanner driver "Epson Scan 2". See the Epson Scan 2 help for an explanation of each setting item.

**Related Information**

⇒ “Application for Scanning Documents and Images (Epson Scan 2)” on page 133

**Scanning Documents (Document Mode)**

Using **Document Mode** in Epson Scan 2, you can scan originals using detailed settings that are suitable for text documents.
1. Place the originals.

2. Start Epson Scan 2.

3. Select **Document Mode** from the **Mode** list.

4. Make the following settings on the **Main Settings** tab.

   - **Document Size:** Select the size of the original you placed.
   - (Original orientation) buttons: Select the set orientation of the original you placed. Depending on the size of the original, this item may be set automatically and cannot be changed.
   - **Image Type:** Select the color for saving the scanned image.
   - **Resolution:** Select the resolution.

   **Note:**
   - The **Document Source** setting is fixed as **Scanner Glass**. You cannot change this setting.
   - If you set **Add or edit pages after scanning**, you can scan additional originals after scanning the original. In addition, if you set the **Image Format** as PDF or Multi-TIFF, you can save the scanned images as one file.

5. Make other scan settings if necessary.

   - You can preview the scanned image by clicking the **Preview** button. The preview window opens, and the previewed image is displayed.
Scanning

- On the **Advanced Settings** tab, you can make detailed image adjustment settings that are suitable for text documents, such as the following.

  - **Remove Background**: Remove the background of the originals.
  - **Text Enhancement**: You can make blurred letters in the original clear and sharp.
  - **Auto Area Segmentation**: You can make letters clear and images smooth when performing black and white scanning for a document that contains images.
  - **Color Enhance**: You can enhance the color specified for the scanned image, and then save it in grayscale or black and white.
  - **Brightness**: You can adjust the brightness for the scanned image.
  - **Contrast**: You can adjust the contrast for the scanned image.
  - **Gamma**: You can adjust the gamma (brightness of the intermediate range) for the scanned image.
  - **Threshold**: You can adjust the border for monochrome binary (black and white).
  - **Unsharp Mask**: You can enhance and sharpen the outlines of the image.
  - **Descreening**: You can remove moiré patterns (web-like shadows) that appear when scanning printed papers such as a magazine.
  - **Edge Fill**: You can remove the shadow created around the scanned image.
  - **Dual Image Output (Windows Only)**: You can scan once and save two images with different output settings at the same time.

**Note:**
*The items may not be available depending on other settings you made.*
6. Set the file saving settings.

- **Image Format**: Select the save format from the list. You can make detailed settings for each save format except BITMAP and PNG. Select **Options** from the list after selecting the save format.

- **File Name**: Confirm the save file name displayed. You can change settings for the file name by selecting **Settings** from the list.

- **Folder**: Select the save folder for the scanned image from the list. You can select another folder or create a new folder by selecting **Select** from the list.

7. Click **Scan**.

**Related Information**

⇒ "Placing Originals" on page 51

### Scanning Photos or Pictures (Photo Mode)

Using **Photo Mode** in Epson Scan 2, you can scan originals with wide variety of image adjustment features that are suitable for photos or pictures.

1. **Place the originals.**

   By placing multiple originals on the scanner glass, you can scan them all at the same time. Make sure there is a gap of at least 20 mm between the originals.
2. Start Epson Scan 2.

3. Select **Photo Mode** from the **Mode** list.

4. Make the following settings on the **Main Settings** tab.

   - **Image Type**: Select the color for saving the scanned image.
   - **Resolution**: Select the resolution.

**Note:**
The **Document Source** setting is fixed as **Scanner Glass**, and the **Document Type** setting is fixed as **Reflective**. (*Reflective* means originals which are not transparent, for example ordinary papers or photos.) You cannot change these settings.
5. Click **Preview**.

The preview window opens, and the previewed images are displayed as thumbnails.

![Preview Window]

**Note:**

To preview the entire scanned area, clear the **Thumbnail** check box at the top of the preview widow.

6. Confirm the preview, and make image adjustment settings on the **Advanced Settings** tab if necessary.

![Advanced Settings]

You can adjust the scanned image using detailed settings that are suitable for photos or pictures, such as the following.

- **Brightness**: You can adjust the brightness for the scanned image.
- **Contrast**: You can adjust the contrast for the scanned image.
- **Saturation**: You can adjust the saturation (color vividness) for the scanned image.
- **Unsharp Mask**: You can enhance and sharpen the outlines of the scanned image.
- **Color Restoration**: You can correct images that have faded to return them to their original colors.
- **Backlight Correction**: You can lighten scanned images that are dark due to backlight.
- **Descreening**: You can remove moiré patterns (web-like shadows) that appear when scanning printed papers such as a magazine.
- **Dust Removal**: You can remove dust on the scanned image.

**Note:**
- The items may not be available depending on other settings you made.
- Depending on the original, the scanned image may not be adjusted correctly.
- When multiple thumbnails are created, you can adjust the image quality for each thumbnail. Depending on the adjustment items, you can adjust the quality of scanned images all together by selecting multiple thumbnails.

7. Set the file saving settings.

- **Image Format**: Select the save format from the list.
  You can make detailed settings for each save format except BITMAP and PNG. Select **Options** from the list after selecting the save format.
- **File Name**: Confirm the save file name displayed.
  You can change settings for the file name by selecting **Settings** from the list.
Folder: Select the save folder for the scanned image from the list. You can select another folder or create a new folder by selecting Select from the list.

8. Click Scan.

Related Information
⇒ “Placing Originals” on page 51

Scanning from Smart Devices

Epson iPrint is an application that allows you to scan photos and documents from a smart device, such as a smartphone or tablet, that is connected to the same wireless network as your printer. You can save the scanned data on a smart device or to Cloud services, send it by email, or print it.

If you start Epson iPrint when the printer is not connected to the network, a message is displayed instructing you to connect to the printer. Follow the instructions to complete the connection. See the URL below for the operating conditions.

http://epson.sn

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Scanning Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.
The following screens are subject to change without notice.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Home screen displayed when the application is started.</td>
</tr>
<tr>
<td>2</td>
<td>Displays information on how to setup the printer and a FAQ.</td>
</tr>
<tr>
<td>3</td>
<td>Displays the screen where you can select the printer and make printer settings. Once you have selected the printer, you do not need to select it again from the next time.</td>
</tr>
<tr>
<td>4</td>
<td>Displays the scanning screen.</td>
</tr>
<tr>
<td>5</td>
<td>The scanning screen displayed when the scan menu is selected.</td>
</tr>
<tr>
<td>6</td>
<td>Displays the screen where you can make scan settings such as resolution.</td>
</tr>
<tr>
<td>7</td>
<td>Displays scanned images.</td>
</tr>
<tr>
<td>8</td>
<td>Starts scanning.</td>
</tr>
<tr>
<td>9</td>
<td>Displays the screen where you can save scanned data to a smart device or Cloud services.</td>
</tr>
<tr>
<td>10</td>
<td>Displays the screen where you can send scanned data by email.</td>
</tr>
<tr>
<td>11</td>
<td>Displays the screen where you can print scanned data.</td>
</tr>
</tbody>
</table>
Replacing Ink Cartridges and Other Consumables

Checking the Status of the Remaining Ink and the Maintenance Box

You can check the approximate ink levels and the approximate service life of the maintenance box from the control panel or the computer.

**Note:**
You can continue printing while the ink low message is displayed. Replace the ink cartridges when required.

Checking the Status of the Remaining Ink and the Maintenance Box - Control Panel

1. Select **Settings > Supply Status** on the home screen.

   To select an item, use the ▲▼◄► buttons, and then press the OK button.

2. Do one of the following.
   - To check the ink level, select **Ink Level**.
   - To check the remaining service life of the maintenance box, select **Maintenance Box Service Life**.

Checking the Status of the Remaining Ink and the Maintenance Box - Windows

1. Access the printer driver window.

2. Click **EPSON Status Monitor 3** on the **Maintenance** tab.

   **Note:**
   If **EPSON Status Monitor 3** is disabled, click **Extended Settings** on the **Maintenance** tab, and then select Enable **EPSON Status Monitor 3**.

Checking the Status of the Remaining Ink and the Maintenance Box - Mac OS X

1. Start the printer driver utility:
   - Mac OS X v10.6.x to v10.9.x
   
   Select **System Preferences** from the **Finder** menu > **Printers & Scanners** (or **Print & Scan**, **Print & Fax**) and then select the printer. Click **Options & Supplies** > **Utility** > **Open Printer Utility**.
Replacing Ink Cartridges and Other Consumables

- Mac OS X v10.5.8

Select System Preferences from the menu > Print & Fax, and then select the printer. Click Open Print Queue > Utility.

2. Click EPSON Status Monitor.

Ink Cartridge Codes

The following are the codes for genuine Epson ink cartridges.

Note:
- Ink cartridge codes may vary by location. For the correct codes in your area, contact Epson support.
- Although the ink cartridges may contain recycled materials, this does not affect printer function or performance.
- Specifications and appearance of the ink cartridge are subject to change without prior notice for improvement.

For Europe

<table>
<thead>
<tr>
<th>Icon</th>
<th>BK: Black</th>
<th>C: Cyan</th>
<th>M: Magenta</th>
<th>Y: Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starfish</td>
<td>603</td>
<td>603</td>
<td>603</td>
<td>603</td>
</tr>
<tr>
<td></td>
<td>603XL*</td>
<td>603XL*</td>
<td>603XL*</td>
<td>603XL*</td>
</tr>
</tbody>
</table>

* "XL" indicates a large cartridge.

Note:
For users in Europe, visit the following website for information on Epson’s ink cartridge yields.
http://www.epson.eu/pageyield

For Australia and New Zealand

<table>
<thead>
<tr>
<th>BK: Black</th>
<th>C: Cyan</th>
<th>M: Magenta</th>
<th>Y: Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td>212</td>
<td>212</td>
<td>212</td>
<td>212</td>
</tr>
<tr>
<td>212XL*</td>
<td>212XL*</td>
<td>212XL*</td>
<td>212XL*</td>
</tr>
</tbody>
</table>

* "XL" indicates a large cartridge.

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may not be displayed.

Related Information
- "Technical Support Web Site” on page 176
Ink Cartridge Handling Precautions

Read the following instructions before replacing ink cartridges.

**Storing precautions for ink**
- Keep the ink cartridges out of direct sunlight.
- Do not store the ink cartridges in high or freezing temperatures.
- Epson recommends using the ink cartridge before the date printed on the package.
- For best results, use up ink cartridge within six months of opening the package.
- For best results, store ink cartridge packages with their bottom down.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Do not open the ink cartridge package until you are ready to install it in the printer. The cartridge is vacuum packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal printing may not be possible.

**Handling precautions for replacing ink cartridges**
- Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.
- You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or you may not be able to print. Do not remove or tear the label on the cartridge; this can cause leakage.
Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become unusable.

Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

Install all ink cartridges; otherwise you cannot print.

Do not replace ink cartridges with the power off. Do not move the print head by hand; otherwise, you may damage the printer.

Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

Do not leave the printer with the ink cartridges removed or do not turn off the printer during cartridge replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

If you need to remove an ink cartridge temporarily, make sure you protect the ink supply area from dirt and dust. Store the ink cartridge in the same environment as the printer, with the ink supply port facing down or sideways. Do not store ink cartridges with the ink supply port facing up. Because the ink supply port is equipped with a valve designed to contain the release of excess ink, there is no need to supply your own covers or plugs.

Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the surrounding area when removing the cartridges.

This printer uses ink cartridges equipped with a green chip that monitors information such as the amount of remaining ink for each cartridge. This means that even if the cartridge is removed from the printer before it is expended, you can still use the cartridge after reinserting it back into the printer. However, when reinserting a cartridge, some ink may be consumed to guarantee printer performance.

For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with low ink status may not be used when reinserted.

To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve remains in the cartridge when your printer indicates to replace the cartridge. The yields quoted for you do not include this reserve.
Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.

You cannot use the cartridges that came with the printer for the replacement.

**Ink consumption**

- To maintain optimum print head performance, some ink is consumed from all cartridges during maintenance operations. Ink may also be consumed when you replace ink cartridge or turn the printer on.
- When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the paper type or print quality settings. This is because a mixture of color inks is used to create black.
- The ink in the ink cartridges supplied with your printer is partly used during initial setup. In order to produce high quality printouts, the print head in your printer will be fully charged with ink. This one-off process consumes a quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink cartridges.
- Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the frequency of your prints and environmental conditions such as temperature.

---

**Replacing Ink Cartridges**

> **Caution:**

Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.

**Note:**

If you replace the ink cartridges while copying, the originals may move out of place. Press the \( \text{ candid } \) button to cancel and replace the originals.

1. Do one of the following.

   To select an item, use the \( \uparrow \) \( \downarrow \) \( \leftarrow \) \( \rightarrow \) buttons, and then press the OK button.
   
   - When prompted to replace ink cartridges
     Check which ink cartridge needs to be replaced, and then press the OK button. Confirm the message, select **Replace now** on the home screen.
   
   - When replacing ink cartridges before they are expended
     Select **Maintenance > Ink Cartridge(s) Replacement** on the home screen.
2. When replacing the black ink cartridge, gently shake the new black ink cartridge four or five times and then remove it from its package. When replacing other color cartridges, remove the new color cartridges from their package without shaking.

Important:
Do not shake cartridges after opening the package, as they may leak.

3. Remove only the yellow tape.

Important:
Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.
4. Open the scanner unit with the document cover closed.

5. Squeeze the tab on the ink cartridge and pull it straight up. If you cannot remove the ink cartridge, pull it firmly.

6. Insert the new ink cartridge, and then press it down firmly.
7. Close the scanner unit.
   For safety, the scanner unit is closed in two steps.

   ![Scanner Unit Closing Steps]

   **Note:**
   *The scanner unit cannot be opened from the position shown below. Close it completely before opening it.*

8. Press the  button.
   Ink charging starts.

   ![Ink Charging]

   **Important:**
   *Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.*

**Related Information**

- “Ink Cartridge Codes” on page 98
- “Ink Cartridge Handling Precautions” on page 99

---

**Maintenance Box Code**

Epson recommends the use of a genuine Epson maintenance box.

Maintenance box code: C9344

**Important:**
*Once a maintenance box has been installed in a printer it cannot be used with other printers.*

---

**Maintenance Box Handling Precautions**

Read the following instructions before replacing the maintenance box.
Replacing a Maintenance Box

In some print cycles a very small amount of surplus ink may be collected in the maintenance box. To prevent ink leakage from the maintenance box, the printer is designed to stop printing when the absorbing capacity of the maintenance box has reached its limit. Whether and how often this is required will vary according to the number of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs. Replace the maintenance box when you are promoted to do so. The Epson Status Monitor, your LCD, or lights on the control panel will advise you when this part needs replacing. The need for replacement of the box does not mean that your printer has ceased to operate in accordance with its specifications. The Epson warranty does not cover the cost of this replacement. It is a user-serviceable part.
Replacing Ink Cartridges and Other Consumables

Note:
- When the maintenance box is full, you cannot print and clean the print head until it is replaced to avoid ink leakage. However, you can perform operations that do not use ink such as scanning.
- When the following screen is displayed, the part cannot be replaced by users. Contact Epson support.

1. Remove the new maintenance box from its package.

   **Important:**
   Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and printing.

   **Note:**
   A transparent bag for the used maintenance box is provided with the new maintenance box.

2. Loosen the screw with a flat-head screwdriver, and then remove the cover.
3. Remove the used maintenance box.

![Image of removing maintenance box]

**Important:**
Do not touch the sections shown in the illustration. Doing so may prevent normal operation and you may get smeared with ink.

![Image of important instruction]

4. Put the used maintenance box in the transparent bag that came with the new maintenance box and seal the bag shut.

![Image of putting in transparent bag]
5. Insert the new maintenance box all the way into the printer. Make sure you insert the box in the correct direction.

6. Reattach the cover.

7. Check the message, and then press the OK button.

---

**Temporarily Printing with Black Ink**

When color ink is expended and black ink still remains, you can use the following settings to continue printing for a short time using only black ink.

- Type of paper: plain papers, Envelope
- Color: B&W or Grayscale
- Borderless: Not selected
- EPSON Status Monitor 3: Enabled (When printing from the printer driver on Windows.)

Because this feature is only available for approximately five days, replace the expended ink cartridge as soon as possible.

*Note:*
- If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and then select Enable EPSON Status Monitor 3.
- The available period varies depending on the usage conditions.
**Temporarily Printing with Black Ink - Windows**

Do one of the following.

- When the following window is displayed, select **Print in Black**.

![EPSON Status Monitor 3](image)

- When the following window is displayed, cancel printing. And then, printing again.

![EPSON Status Monitor 3: EPSON XXXXX Series](image)

**Note:**

*If you cannot cancel printing from the computer, cancel using the printer's control panel.*

Follow the steps below when printing again.

1. Access the printer driver window.
2. Clear **Borderless** on the **Main** tab.
3. Select **plain papers** or **Envelope** as the **Paper Type** setting on the **Main** tab.
4. Select **Grayscale**.
5. Set the other items on the **Main** and **More Options** tabs as necessary, and then click **OK**.
6. Click Print.

7. Click Print in Black in the window displayed.

**Temporarily Printing with Black Ink - Mac OS**

*Note:*
To use this feature through a network, connect with Bonjour.

1. Click the printer icon in the Dock.

2. Cancel the job.
   
   *Note:*
   If you cannot cancel printing from the computer, cancel using the printer's control panel.

3. Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies > Options (or Driver).

4. Select On as the Permit temporary black printing setting.

5. Access the print dialog.

6. Select Print Settings from the pop-up menu.

7. Select any paper size except for a borderless size as the Paper Size setting.

8. Select plain papers or Envelope as the Media Type setting.


10. Set the other items as necessary.

11. Click Print.

**Conserving Black Ink when the Black Ink Is Low (for Windows Only)**

When black ink is running low and there is enough color ink remaining, you can use a mixture of color inks to create black. You can continue printing while preparing a replacement black ink cartridge.

This feature is only available when you select the following settings in the printer driver.

- Paper Type: plain papers
- Quality: Standard
- EPSON Status Monitor 3: Enabled
Note:

- If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and then select Enable EPSON Status Monitor 3.
- Composite black looks slightly different from pure black. In addition, the print speed is reduced.
- To maintain the quality of the print head, black ink is also consumed.

---

Options | Description
---|---
Yes | Select to use a mixture of color inks to create black. This window is displayed the next time you print a similar job.
No | Select to continue using the remaining black ink. This window is displayed the next time you print a similar job.
Disable this feature | Select to continue using the remaining black ink. This window is not displayed until you replace the black ink cartridge and it runs low again.
Maintaining the Printer

Preventing the Print Head from Drying

Always use the power button when turning the printer on and off.
Check that the power light is off before you disconnect the power cord.
The ink itself can dry out if it is not covered. Just like placing a cap on a fountain pen or an oil pen to prevent it from drying, make sure the print head is capped properly to prevent the ink from drying.
When the power cord is unplugged or a power outage occurs while the printer is in operation, the print head may not be capped properly. If the print head is left as it is, it will dry out causing nozzles (ink outlets) to clog.
In these cases, turn the printer on and off again as soon as possible to cap the print head.

Checking and Cleaning the Print Head

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. When print quality has declined, use the nozzle check feature and check if the nozzles are clogged. If the nozzles are clogged, clean the print head.

Important:
- Do not open the scanner unit or turn off the printer during head cleaning. If the head cleaning is incomplete, you may not be able to print.
- Because print head cleaning uses some ink, clean the print head only if quality declines.
- When ink is low, you may not be able to clean the print head.
- If print quality has not improved after repeating nozzle check and head cleaning about four times, wait for at least six hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We recommend to turn off the printer. If print quality has still not improved, contact Epson support.
- To prevent the print head from drying out, do not unplug the printer while the power is on.

Checking and Cleaning the Print Head - Control Panel

1. Load A4-size plain paper in the printer.
2. Select Maintenance on the home screen.
   - To select an item, use the ▲▼◄► buttons, and then press the OK button.
3. Select Nozzle Check.
4. Follow the on-screen instructions to print the nozzle check pattern.
5. Examine the printed pattern.
   - If you cannot see any broken lines or missing segments as in the following "OK" pattern, the nozzles are not clogged. Select No to close the nozzle check feature. No further steps are necessary.
If there are broken lines or missing segments as shown in the "NG" pattern, the print head nozzles may be clogged. Go to the next step.

6. Select Yes, and then follow the on-screen instructions to clean the print head.

7. When cleaning is finished, print the nozzle check pattern again. Repeat cleaning and printing the pattern until all lines are printed completely.

Related Information

- “Loading Paper in the Rear Paper Feed” on page 47

Checking and Cleaning the Print Head - Windows

1. Load A4-size plain paper in the printer.

2. Access the printer driver window.

3. Click Nozzle Check on the Maintenance tab.

4. Follow the on-screen instructions.

Related Information

- “Loading Paper in the Rear Paper Feed” on page 47
- “Windows Printer Driver” on page 127

Checking and Cleaning the Print Head - Mac OS

1. Load A4-size plain paper in the printer.

2. Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer.

3. Click Options & Supplies > Utility > Open Printer Utility.

4. Click Nozzle Check.

5. Follow the on-screen instructions.
Aligning the Print Head

If print results contain the following problems, align the print head to improve the printouts.

- Vertical lines look misaligned or the printouts look blurry
- Horizontal banding occurs at regular intervals

Aligning the Print Head - Control Panel

1. Select Maintenance on the home screen.
   - To select an item, use the ▲ ▼ ◄► buttons, and then press the OK button.
2. Select Print Head Alignment.
3. Select the adjustment menu you want to adjust to improve the printouts according to the status of the print results.
   - Vertical lines look misaligned or the printouts look blurry: Select Vertical Alignment.
   - Horizontal banding occurs at regular intervals: Select Horizontal Alignment.
4. Follow the on-screen instructions.

Cleaning the Paper Path for Ink Smears

When the printouts are smeared or scuffed, clean the roller inside.

⚠️ Important:
Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

1. Load A4-size plain paper in the printer.
2. Select Maintenance on the home screen.
   - To select an item, use the ▲ ▼ ◄► buttons, and then press the OK button.
4. Follow the on-screen instructions to clean the paper path.

Note:
Repeat this procedure until the paper is not smeared with ink.
Cleaning the Scanner Glass

When the copies or scanned images are smeared, clean the scanner glass.

![Image of printer]

1. Open the document cover.

2. Use a soft, dry, clean cloth to clean the surface of the scanner glass.

   ![Important:]
   - Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.

   ![Important:]
   - If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of glass cleaner and a soft cloth to remove it. Wipe off all remaining liquid.
   - Do not press the glass surface too hard.
   - Be careful not to scratch or damage the surface of the glass. A damaged glass surface can decrease the scan quality.

Cleaning the Translucent Film

When the printout is not improved after aligning the print head or cleaning the paper path, the translucent film inside the printer may be smeared.

Items required:
- Cotton swabs (several)
- Water with a few drops of detergent (2 to 3 drops of detergent in 1/4 cup of tap water)
- Light for checking smears
Important:
Do not use cleaning liquid other than water with a few drops of detergent.

1. Turn off the printer by pressing the $P$ button.

2. Open the scanner unit.

3. Check if the translucent film is smeared. Smears are easier to see if you use a light.
   If there are smears (such as finger marks or grease) on the translucent film (A), go to the next step.

A: Translucent film
B: Rail
4. Moisten a cotton swab with the water with a few drops of detergent so that it is not dripping water, and then wipe the smeared part.

**Important:**

Be careful not to touch the rail (B). Otherwise, you may not be able to print. Do not wipe off the grease on the rail, because this is necessary for operations.

5. Use a new dry cotton swab to wipe the film.

**Important:**

Wipe off the smear gently. If you press the cotton swab too hard to the film, the springs of the film may be dislocated and the printer may be damaged.

**Important:**

Do not leave any fibers on the film.

**Note:**

To prevent the smear from spreading, frequently replace the cotton swab with a new one.

6. Repeat steps 4 and 5 until the film is not smeared.

7. Visually check that the film is not smeared.

**Saving Power**

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please consider the environment before making any change.

Depending on the location of purchase, the printer may have a feature that turns it off automatically if it is not connected to the network for 30 minutes.
Saving Power - Control Panel

1. Select **Settings** on the home screen.
   
   To select an item, use the ▲ ▼ ◀▶ buttons, and then press the OK button.

2. Select **Printer Setup**.

3. Do one of the following.
   
   **Note:**
   Your product may have the **Power Off Settings** or **Power Off Timer** feature depending on the location of purchase.

   - Select **Sleep Timer** or **Power Off Settings > Power Off If Inactive** or **Power Off If Disconnected**, and then make settings.
   - Select **Sleep Timer** or **Power Off Timer**, and then make settings.
Menu Options for Settings

Select Settings on the home screen of the printer to make various settings.

Menu Options for Supply Status

Select the menu on the control panel as described below.

Settings > Supply Status

Ink Level:
Displays the approximate levels of the ink cartridges. When ! is displayed, the ink cartridge is running low. When ✗ is displayed, the ink cartridge is expended.
You can replace ink cartridges from this screen.

Maintenance Box Service Life:
Displays the approximate service life of the maintenance box. When ! is displayed, the maintenance box is nearly full. When ✗ is displayed, the maintenance box is full.

Menu Options for Maintenance

Select the menus on the control panel as described below.

Settings > Maintenance

Nozzle Check:
Select this feature to check if the print head nozzles are clogged. The printer prints a nozzle check pattern.

Head Cleaning:
Select this feature to clean clogged nozzles in the print head.

Print Head Alignment:
Select this feature to adjust the print head to improve print quality.
☑ Vertical Alignment
Select this feature if your printouts look blurry or text and lines are misaligned.
☑ Horizontal Alignment
Select this feature if horizontal banding appears at regular intervals in your printouts.

Ink Cartridge(s) Replacement:
Use this feature to replace the ink cartridge before the ink is expended.
Paper Guide Cleaning:
Select this feature if there are ink stains on the internal rollers. The printer feeds paper to clean the internal rollers.

Related Information
- “Checking and Cleaning the Print Head” on page 112
- “Replacing Ink Cartridges” on page 101
- “Cleaning the Paper Path for Ink Smears” on page 114

Menu Options for Printer Setup

Select the menus on the control panel as described below.

Settings > Printer Setup

Paper Source Settings:

Paper Setup:
Select the paper size and paper type you loaded in the paper source.

Paper Setup Auto Display:
Select On to display the Paper Setup screen when loading paper in the paper source. If you disable this feature, you cannot print from an iPhone, iPad, or iPod touch using AirPrint.

Quiet Mode:
Your product may not have this feature depending on the location of purchase.
Select On to reduce noise during printing, however, this may lower the print speed. Depending on the paper type and print quality settings you selected, there may be no difference in the printer’s noise level.

Power Off Timer:
Your product may have this feature or the Power Off Settings feature depending on the location of purchase.
Select this setting to turn the printer off automatically when it is not used for a specified period of time. You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency. Please consider the environment before making any change.

Power Off Settings:
Your product may have this feature or the Power Off Timer feature depending on the location of purchase.

- Power Off If Inactive
Select this setting to turn the printer off automatically if it is not used for a specified period of time. Any increase will affect the product’s energy efficiency. Please consider the environment before making any change.
Menu Options for Settings

- **Power Off IfDisconnected**
  Select this setting to turn the printer off after 30 minutes when all ports including the USB port are disconnected. This feature may not be available depending on your region.

**Language:**
Select the language used on the LCD screen.

**Keyboard**
Change the layout of the keyboard on the LCD screen.

**Sleep Timer:**
Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not performed any operations. The LCD screen turns black when the setting time passes.

**Ink Drying Time:**
Select the ink drying time you want to use when performing 2-sided printing. The printer prints the other side after printing one side. If your printout is smeared, increase the time setting.

Related Information

- “Saving Power - Control Panel” on page 118
- “Entering Characters” on page 17

Menu Options for Network Settings

Select the menus on the control panel as described below.

**Settings > Network Settings**

**Print Status Sheet:**
Prints a network status sheet.

**Wi-Fi Setup:**
Set up or change wireless network settings. Choose the connection method from following and then follow the instructions on the control panel.

- **Wi-Fi (Recommended)**
- **Wi-Fi Direct**

**Connection Check:**
Checks the status of the network connection and prints the network connection report. If there are any problems with the connection, see the check report to solve the problem.

Related Information

- “Making Wi-Fi Settings by Entering the SSID and Password” on page 31
- “Making Wi-Fi Settings by Push Button Setup” on page 32
- “Making Wi-Fi Settings by PIN Code Setup (WPS)” on page 33
Menu Options for Epson Connect Services

Select the menus on the control panel as described below.

**Settings > Epson Connect Services**

Register/Delete:
- Register or delete the printer to or from the Epson Connect services.
- For usage guides, see the following portal website.
  - https://www.epsonconnect.com/
  - http://www.epsonconnect.eu (Europe only)

Suspend/Resume:
- Select whether to suspend or resume Epson Connect services.

Email Address:
- Check the printer's email address that is registered to the Epson Connect services.

Status:
- Check whether or not the printer is registered and connected to the Epson Connect services.

Menu Options for Google Cloud Print Services

Select the menus on the control panel as described below.

**Settings > Google Cloud Print Services**

Suspend/Resume:
- Select whether to suspend or resume the Google Cloud Print services.

Unregister:
- Unregister the Google Cloud Print services.

Status:
- Check whether or not the printer is registered and connected to the Google Cloud Print services.

For registration and usage guides, see the following portal website.
- https://www.epsonconnect.com/
- http://www.epsonconnect.eu (Europe only)
Menu Options for Guide Functions

Select the menus on the control panel as described below.

**Settings > Guide Functions**

**Paper Mismatch**

Displays a warning if the paper settings (print settings) for the print job do not match the printer’s paper settings made when you loaded the paper. This setting prevents misprinting. When **Paper Setup Auto Display** is disabled in the following menu, the paper setting screen is not displayed. In this situation, you cannot print from an iPhone, iPad, or iPod touch using AirPrint.

**Settings > Printer Setup > Paper Source Settings**

Menu Options for Customer Research

Select the menus on the control panel as described below.

**Settings > Customer Research**

Select **Approve** to provide product usage information such as the number of prints to Seiko Epson Corporation.

Menu Options for Firmware Update

Select the menus on the control panel as described below.

**Settings > Firmware Update**

**Update:**

Checks if the latest version of the firmware has been uploaded to the network server. If an update is available, you can select whether or not to start updating.

**Current Version:**

Displays the current firmware version of your printer.

**Notification:**

Checks for firmware updates periodically and notifies you if an update is available.

Menu Options for Restore Default Settings

Select the menus on the control panel as described below.

**Settings > Restore Default Settings**

**Network Settings:**

Resets the network settings to their defaults.
Menu Options for Settings

All except Network:
  Resets all settings except for network settings to their defaults.

All Settings:
  Resets all settings to their defaults.
Network Service and Software Information

This section introduces the network services and software products available for your printer from the Epson website or the supplied software disc.

Epson Connect Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or laptop, anytime and practically anywhere.

The features available on the Internet are as follows.

<table>
<thead>
<tr>
<th>Email Print</th>
<th>Epson iPrint remote print</th>
<th>Scan to Cloud</th>
<th>Remote Print Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>–</td>
<td>✓</td>
</tr>
</tbody>
</table>

See the Epson Connect portal website for details.
https://www.epsonconnect.com/
http://www.epsonconnect.eu (Europe only)

Application for Configuring Printer Operations (Web Config)

Web Config is an application that runs in a web browser, such as Internet Explorer and Safari, on a computer or smart device. You can confirm the printer status or change the network service and printer settings. To use the Web Config, connect the printer and the computer or device to the same network.

The following browsers are supported.

<table>
<thead>
<tr>
<th>OS</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP SP3 or later</td>
<td>Microsoft Edge, Internet Explorer 8 or later, Firefox*, Chrome*</td>
</tr>
<tr>
<td>Mac OS X v10.6.8 or later</td>
<td>Safari*, Firefox*, Chrome*</td>
</tr>
<tr>
<td>iOS*</td>
<td>Safari*</td>
</tr>
<tr>
<td>Android 2.3 or later</td>
<td>Default browser</td>
</tr>
<tr>
<td>Chrome OS*</td>
<td>Default browser</td>
</tr>
</tbody>
</table>

* Use the latest version.
Running Web Config on a Web Browser

1. Check the printer’s IP address.
   Select **Settings > Network Settings > Connection Check** from the control panel to start the connection check. Press the ◇ button or the OK button to print the network connection report. Check the printer's IP address on the printed network connection report.

2. Launch a Web browser from a computer or smart device, and then enter the printer’s IP address.
   Format:
   - IPv4: http://the printer’s IP address/
   - IPv6: http://[the printer's IP address]/
   Examples:
   - IPv4: http://192.168.100.201/
   - IPv6: http://[2001:db8::1000:1]/
   **Note:** Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information
- “Printing a Network Connection Report” on page 34
- “Using Epson iPrint” on page 74

Running Web Config on Windows

When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1. Open the printer list on the computer.
   - Windows 10
     Click on the start button, and then select **Windows System > Control Panel > View devices and printers** in **Hardware and Sound**.
   - Windows 8.1/Windows 8
     Select **Desktop > Settings > Control Panel > View devices and printers** in **Hardware and Sound** (or **Hardware**).
   - Windows 7
     Click the start button, and select **Control Panel > View devices and printers** in **Hardware and Sound**.
   - Windows Vista
     Click the start button, and select **Control Panel > Printers** in **Hardware and Sound**.

2. Right-click on your printer and select **Properties**.

3. Select the **Web Service** tab and click the URL.
Running Web Config on Mac OS

1. Select **System Preferences** from the menu > **Printers & Scanners** (or **Print & Scan**, **Print & Fax**), and then select the printer.

2. Click **Options & Supplies** > **Show Printer Webpage**.

Windows Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the printer driver provides the best printing results. You can also check the status of the printer or keep it in top operating condition using the printer driver utility.

*Note:*
You can change the language of the printer driver. Select the language you want to use from the **Language** setting on the **Maintenance** tab.

Accessing the printer driver from applications

To make settings that apply only to the application you are using, access from that application.

Select **Print** or **Print Setup** from the **File** menu. Select your printer, and then click **Preferences** or **Properties**.

*Note:*
Operations differ depending on the application. See the application's help for details.

Accessing the printer driver from the control panel

To make settings that apply to all of the applications, access from the control panel.

- **Windows 10**
  
  Click on the start button, and then select **Windows System** > **Control Panel** > **View devices and printers** in **Hardware and Sound**. Right-click on your printer, or press and hold it and then select **Printing preferences**.

- **Windows 8.1/Windows 8**
  
  Select **Desktop** > **Settings** > **Control Panel** > **View devices and printers** in **Hardware and Sound**. Right-click on your printer, or press and hold it and then select **Printing preferences**.

- **Windows 7**
  
  Click the start button, and select **Control Panel** > **View devices and printers** in **Hardware and Sound**. Right-click on your printer and select **Printing preferences**.

- **Windows Vista**
  
  Click the start button, and select **Control Panel** > **Printers** in **Hardware and Sound**. Right-click on your printer and select **Select printing preferences**.

- **Windows XP**
  
  Click the start button, and select **Control Panel** > **Printers and Other Hardware** > **Printers and Faxes**. Right-click on your printer and select **Printing preferences**.

Accessing the printer driver from the printer icon on the task bar

The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select **Printer Settings**, you can access the same printer settings window as the one displayed from the control panel. If you double-click this icon, you can check the status of the printer.
Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the Maintenance tab, and then select Register the shortcut icon to the taskbar.

Starting the utility
Access the printer driver window. Click the Maintenance tab.

Guide to Windows Printer Driver
Help is available in the printer driver for Windows. To view explanations of the setting items, right-click on each item, and then click Help.

Main Tab
You can make basic settings for printing, such as paper type or paper size.
You can also make settings for printing both sides of the paper or printing multiple pages on one sheet.
More Options Tab
You can select additional layout and printing options such as changing the size of a printout or making color corrections.

Maintenance Tab
You can run maintenance features such as nozzle check and print head cleaning, and by starting EPSON Status Monitor 3, you can check printer status and error information.

Making Operation Settings for the Windows Printer Driver
You can make settings such as enabling EPSON Status Monitor 3.
1. Access the printer driver window.
2. Click **Extended Settings** on the **Maintenance** tab.
3. Make the appropriate settings, and then click **OK**.
   See the online help for explanations of the setting items.

### Mac OS Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the printer driver provides the best printing results. You can also check the status of the printer or keep it in top operating condition using the printer driver utility.

**Accessing the printer driver from applications**

Click **Page Setup** or **Print** on the **File** menu of your application. If necessary, click **Show Details** (or ▼) to expand the print window.

*Note:*
Depending on the application being used, **Page Setup** may not be displayed in the **File** menu, and the operations for displaying the print screen may differ. See the application's help for details.

**Starting the utility**

Select **System Preferences** from the **»** menu > **Printers & Scanners** (or **Print & Scan**, **Print & Fax**), and then select the printer. Click **Options & Supplies** > **Utility** > **Open Printer Utility**.
Guide to Mac OS Printer Driver

Print dialog
Switch the pop-up menu on the center of the screen to show more items.

<table>
<thead>
<tr>
<th>Pop-up Menu</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>You can select a layout for printing several pages on one sheet or select to print a border.</td>
</tr>
<tr>
<td>Color Matching</td>
<td>You can adjust the colors.</td>
</tr>
<tr>
<td>Paper Handling</td>
<td>You can reduce or enlarge the size of the print job to automatically fit the paper size you loaded.</td>
</tr>
<tr>
<td>Cover Page</td>
<td>You can select a cover for your documents. Select Cover Page Type to set the contents to be printed on the cover.</td>
</tr>
<tr>
<td>Print Settings</td>
<td>You can make the basic print settings such as paper type and print quality.</td>
</tr>
<tr>
<td>Color Options</td>
<td>When you select EPSON Color Controls from the Color Matching menu, you can select a color correction method.</td>
</tr>
<tr>
<td>Two-sided Printing</td>
<td>You can select a binding direction for 2-sided printing or select a document type.</td>
</tr>
</tbody>
</table>

Note:
On OS X Mountain Lion or later, if Print Settings menu is not displayed, Epson printer driver has not been installed correctly.

Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and then add the printer again. Access the following website, and then enter the product name. Go to Support, and then see Tips.

http://epson.sn
Epson Printer Utility

You can run a maintenance feature such as nozzle check and print head cleaning, and by starting EPSON Status Monitor, you can check printer status and error information.

Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS Printer Driver

- Skip Blank Page: Avoids printing blank pages.
- Quiet Mode: Prints quietly. However, the print speed may be slower.
- Permit temporary black printing: Prints only with black ink temporarily.
- High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the quality may decline.
- Output documents for filing: Feed the paper so that it is easy to file when printing landscape data or 2-sided printing. Envelope printing is not supported.
- Remove white borders: Removes unnecessary margins during borderless printing.
- Warning Notifications: Allows the printer driver to display warning notifications.
- Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer information is impossible because the printer is shared with Windows computers on a network or for any other reason.
Application for Scanning Documents and Images (Epson Scan 2)

Epson Scan 2 is an application for controlling scanning. You can adjust the size, resolution, brightness, contrast, and quality of the scanned image. You can also start Epson Scan 2 from a TWAIN-compliant scanning application. See the application’s help for details.

Starting on Windows

- Windows 10
  - Click the start button, and then select EPSON > Epson Scan 2.

- Windows 8.1/Windows 8
  - Enter the application name in the search charm, and then select the displayed icon.

- Windows 7/Windows Vista/Windows XP
  - Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2.

Starting on Mac OS

Note: Epson Scan 2 does not support the Mac OS fast user switching feature. Turn off fast user switching.

Select Go > Applications > Epson Software > Epson Scan 2.

Related Information

- “Scanning Documents (Document Mode)” on page 88
- “Installing Applications” on page 135

Adding the Network Scanner

Before using Epson Scan 2, you need to add the network scanner.

1. Start the software, and then click Add on the Scanner Settings screen.

   Note:
   - If Add is grayed out, click Enable Editing.
   - If the main screen of Epson Scan 2 is displayed, it has already been connected to the scanner. If you want to connect to another network, select Scanner > Settings to open the Scanner Settings screen.

2. Add the network scanner. Enter the following items, and then click Add.

   - Model: Select the scanner you want to connect to.
   - Name: Enter the scanner name within 32 characters.
   - Search for Network: When the computer and the scanner are on the same network, the IP address is displayed. If it is not displayed, click the button. If the IP address is still not displayed, click Enter address, and then enter the IP address directly.

3. Select the scanner on the Scanner Settings screen, and then click OK.
Application for Configuring Scanning Operations from the Control Panel (Epson Event Manager)

Epson Event Manager is an application that allows you to manage scanning from the control panel and save images to a computer. You can add your own settings as presets, such as the document type, the save folder location, and the image format. See the application's help for details.

Starting on Windows

- Windows 10
  Click the start button, and then select **Epson Software > Event Manager**.

- Windows 8.1/Windows 8
  Enter the application name in the search charm, and then select the displayed icon.

- Windows 7/Windows Vista/Windows XP
  Click the start button, and then select **All Programs or Programs > Epson Software > Event Manager**.

Starting on Mac OS

Go > Applications > Epson Software > Event Manager.

Related Information

⇒ "Installing Applications" on page 135

Application for Printing Images (Epson Photo+)

Epson Photo+ is an application that allows you to easily print images with a variety of layouts. You can also perform image correction and adjust the position while viewing a preview of your document. You can also brighten up your images by adding text and stamps wherever you like. When printing on genuine Epson photo paper, the ink performance is maximized creating a beautiful finish with excellent coloring.

See the application's help for details.

Note:
To use this application the printer driver for this printer must be installed.

Starting

- Windows 10
  Click the start button, and then select **Epson Software > Epson Photo+**.

- Windows 8.1/Windows 8
  Enter the application name in the search charm, and then select the displayed icon.

- Windows 7/Windows Vista/Windows XP
  Click the start button, and select **All Programs or Programs > Epson Software > Epson Photo+**.

Starting on Mac OS

Select Go > Applications > Epson Software > Epson Photo+.
Software Update Tools (EPSON Software Updater)

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it. You can also update the printer’s firmware and manual.

Installing Method
Download EPSON Software Updater from the Epson website.
If you are using a Windows computer and cannot to download it from the website, you can install it from the supplied software disc.
http://www.epson.com

Starting on Windows
- Windows 10
  Click the start button, and then select **Epson Software > EPSON Software Updater**.
- Windows 8.1/Windows 8
  Enter the application name in the search charm, and then select the displayed icon.
- Windows 7/Windows Vista/Windows XP
  Click the start button, and then select **All Programs or Programs > Epson Software > EPSON Software Updater**.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting **Software Update**.

Starting on Mac OS
Select **Go > Applications > Epson Software > EPSON Software Updater**.

Installing Applications
Connect your computer to the network and install the latest version of applications from the website.

Note:
- Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.
- When reinstalling an application, you need to uninstall it first.

1. Quit all running applications.

2. When installing the printer driver or Epson Scan 2, disconnect the printer and the computer temporarily.

   Note:
   Do not connect the printer and the computer until you are instructed to do so.
3. Access to the following website, and then enter the product name.
   http://epson.sn
4. Select Setup, and then click Download.
5. Click or double-click the downloaded file, and then follow the on-screen instructions.
   **Note:**
   If you are using a Windows computer and you cannot download applications from the website, install them from the software disc that came with the printer.

**Related Information**
- “Software Update Tools (EPSON Software Updater)” on page 135
- “Uninstalling Applications” on page 137

---

### Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.
2. Start EPSON Software Updater, and update the applications or the firmware.

   **Important:**
   Do not turn off the computer or the printer until the update is complete; otherwise, the printer may malfunction.

   **Note:**
   If you cannot find the application you want to update in the list, you cannot update using the EPSON Software Updater. Check for the latest versions of the applications from your local Epson website.
   http://www.epson.com

### Updating the Printer's Firmware using the Control Panel

If the printer is connected to the Internet, you can update the printer's firmware using the control panel. You can also set the printer to regularly check for firmware updates and notify you if any are available.

1. Select **Settings** on the home screen.
   To select an item, use the ▲▼◄► buttons, and then press the OK button.
2. Select **Firmware Update > Update**.
   **Note:**
   Enable **Notification** to set the printer to regularly check for available firmware updates.
3. Check the message displayed on the screen and press the OK button to start searching for available updates.
4. If a message is displayed on the LCD screen informing you that a firmware update is available, follow the on-screen instructions to start the update.

<table>
<thead>
<tr>
<th>Important:</th>
</tr>
</thead>
<tbody>
<tr>
<td>❏ Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.</td>
</tr>
<tr>
<td>❏ If the firmware update is not completed or is unsuccessful, the printer does not start up normally and &quot;Recovery Mode&quot; is displayed on the LCD screen the next time the printer is turned on. In this situation, you need to update the firmware again using a computer. Connect the printer to the computer with a USB cable. While &quot;Recovery Mode&quot; is displayed on the printer, you cannot update the firmware over a network connection. On the computer, access your local Epson website, and then download the latest printer firmware. See the instructions on the website for the next steps.</td>
</tr>
</tbody>
</table>

### Uninstalling Applications

Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

#### Uninstalling Applications - Windows

1. Press the button to turn off the printer.

2. Quit all running applications.

3. Open Control Panel:
   
   ❏ Windows 10
   
   Click on the start button, and then select **Windows System > Control Panel.**
   
   ❏ Windows 8.1/WINDOWS 8
   
   Select **Desktop > Settings > Control Panel.**
   
   ❏ Windows 7/WINDOWS Vista/WINDOWS XP
   
   Click the start button and select **Control Panel.**

4. Open **Uninstall a program** (or **Add or Remove Programs**):
   
   ❏ Windows 10/Windows 8.1/Windows 8/Windows 7/WINDOWS Vista
   
   Select **Uninstall a program in Programs.**
   
   ❏ Windows XP
   
   Click **Add or Remove Programs.**

5. Select the application you want to uninstall.

   You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before uninstalling.

6. Uninstall the applications:
   
   ❏ Windows 10/Windows 8.1/Windows 8/Windows 7/WINDOWS Vista
   
   Click **Uninstall/Change** or **Uninstall.**
Windows XP

Click Change/Remove or Remove.

Note: If the User Account Control window is displayed, click Continue.

7. Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1. Download the Uninstaller using EPSON Software Updater.
   Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the application.

2. Press the button to turn off the printer.

3. To uninstall the printer driver, select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then remove the printer from the enabled printers list.

4. Quit all running applications.

5. Select Go > Applications > Epson Software > Uninstaller.

6. Select the application you want to uninstall, and then click Uninstall.

Important: The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer driver again.

Note: If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall, and then drag it to the trash icon.

Related Information

⇒ “Software Update Tools (EPSON Software Updater)” on page 135
Checking the Printer Status

Checking Error Codes on the LCD Screen

A code is displayed on the LCD screen if there is an error or information that requires your attention. If a code is displayed, follow the solutions below to solve the problem.

<table>
<thead>
<tr>
<th>Code</th>
<th>Situation</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-01</td>
<td>A printer error has occurred.</td>
<td>Open the scanner unit and remove any paper or protective material inside the printer. Turn the power off and on again.</td>
</tr>
<tr>
<td>E-02</td>
<td>A scanner error has occurred.</td>
<td>Turn the power off and on again.</td>
</tr>
<tr>
<td>E-12</td>
<td>A borderless printing ink pad needs to be replaced.</td>
<td>Contact Epson or an authorised Epson service provider to replace the borderless printing ink pad*. It is not a user-serviceable part. Borderless printing is not available, but printing with a border is available.</td>
</tr>
<tr>
<td>W-01</td>
<td>A paper jam has occurred.</td>
<td>Remove the paper from the printer and press the button displayed on the bottom of the LCD screen to clear the error. In some cases, you need to turn the power off and on again.</td>
</tr>
<tr>
<td>W-12</td>
<td>Ink cartridges are installed incorrectly.</td>
<td>Press the ink cartridge down firmly.</td>
</tr>
<tr>
<td>W-13</td>
<td>The ink cartridge displayed on the LCD screen has not been recognized.</td>
<td>Replace the ink cartridge. Epson recommends the use of genuine Epson ink cartridges.</td>
</tr>
<tr>
<td>W-14</td>
<td>A borderless printing ink pad is nearing the end of its service life.</td>
<td>Contact Epson or an authorised Epson service provider to replace the borderless printing ink pad*. It is not a user-serviceable part. The message will be displayed until the ink pad is replaced. Press the button to resume printing.</td>
</tr>
<tr>
<td>I-22</td>
<td>Set Wi-Fi from the Push Button (WPS).</td>
<td>Push the access point button. If there is no button on the access point, open the access point setting window, and then click the button displayed in the software.</td>
</tr>
<tr>
<td>I-23</td>
<td>Set Wi-Fi from the PIN Code (WPS).</td>
<td>Enter the PIN code displayed on the LCD screen into the access point or computer within two minutes.</td>
</tr>
<tr>
<td>I-31</td>
<td>Set Wi-Fi from the Wi-Fi Auto Connect.</td>
<td>Install the software on your computer, and then press the OK button when Wi-Fi setup starts.</td>
</tr>
<tr>
<td>I-41</td>
<td>Paper Setup Auto Display is disabled. Some functions cannot be used.</td>
<td>If Paper Setup Auto Display is disabled, you cannot use AirPrint.</td>
</tr>
<tr>
<td>I-60</td>
<td>Your computer may not support WSD (Web Services for Devices).</td>
<td>The scan to computer (WSD) feature is only available for computers running English versions of Windows 10, Windows 8.1, Windows 8, Windows 7 or Windows Vista. Make sure that the printer is correctly connected to the computer.</td>
</tr>
</tbody>
</table>
The printer has started in recovery mode because the firmware update failed. Follow the steps below to try to update the firmware again.

1. Connect the computer and the printer with a USB cable. (During recovery mode, you cannot update the firmware over a network connection.)
2. Visit your local Epson website for further instructions.

* In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage from the pad, the printer is designed to stop printing when the pad has reached its limit. Whether and how often this is required will vary according to the number of pages you print using the borderless print option. The need for replacement of the pad does not mean that your printer has ceased to operate in accordance with its specifications. The printer will advise you when the pad requires replacing and this can only be performed by an authorised Epson Service provider. The Epson warranty does not cover the cost of this replacement.

Related Information

- "Removing Jammed Paper" on page 141
- "Contacting Epson Support" on page 176
- "Installing Applications" on page 135

Checking the Printer Status - Windows

1. Access the printer driver window.
2. Click **EPSON Status Monitor 3** on the **Maintenance** tab.

   **Note:**
   - You can also check the printer status by double-clicking the printer icon on the taskbar. If the printer icon is not added to the taskbar, click **Monitoring Preferences** on the **Maintenance** tab, and then select **Register the shortcut icon to the taskbar**.
   - If **EPSON Status Monitor 3** is disabled, click **Extended Settings** on the **Maintenance** tab, and then select **Enable EPSON Status Monitor 3**.

Related Information

- "Windows Printer Driver" on page 127

Checking the Printer Status - Mac OS

1. Select **System Preferences** from the **menu > Printers & Scanners** (or **Print & Scan, Print & Fax**), and then select the printer.
2. Click **Options & Supplies > Utility > Open Printer Utility**.
3. Click **EPSON Status Monitor**.
   You can check the printer status, ink levels, and error status.
Checking the Software Status

You may be able to clear the problem by updating the software to the latest version. To check the software status, use the software update tool.

Related Information

➤ “Software Update Tools (EPSON Software Updater)” on page 135
➤ “Installing Applications” on page 135

Removing Jammed Paper

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including any torn pieces. Next, clear the error.

⚠️ Important:

Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

Removing Jammed Paper from the Rear Paper Feed

Remove the jammed paper.

Removing Jammed Paper from Inside the Printer

⚠️ Caution:

- Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.
- Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it could cause an injury. Be careful not to touch the protruding parts to avoid injury.
1. Open the scanner unit with the document cover closed.

2. Remove the jammed paper.

**Important:**

Do not touch the white flat cable or translucent film inside the printer. Doing so may cause a malfunction.
3. Close the scanner unit.
   For safety, the scanner unit is closed in two steps.

   ![Image of scanner unit closing steps]

   **Note:**
The scanner unit cannot be opened from the position shown below. Close it completely before opening it.

---

**Removing Jammed Paper from Rear Cover**

1. Remove the rear cover.

   ![Image of removing rear cover]

2. Remove the jammed paper.

   ![Image of removing jammed paper]
3. Remove jammed paper from the rear cover.

4. Insert the rear cover in the printer.

**Paper Does Not Feed Correctly**

Check the following points, and then take the appropriate actions to solve the problem.

- Place the printer on a flat surface and operate in the recommended environmental conditions.
- Use paper supported by this printer.
- Follow the paper handling precautions.
- Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load above the line indicated by the triangle symbol on the edge guide.
- Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the printer.
- Do not place objects on the feeder guard.

**Related Information**

- “Environmental Specifications” on page 172
- “Paper Handling Precautions” on page 44
- “Available Paper and Capacities” on page 45
- “List of Paper Type” on page 47

**Paper Jams**

- Load paper in the correct direction, and slide the edge guides against the edges of the paper.
- Load one sheet of paper at a time if you have loaded several sheets of paper.

**Related Information**

- “Removing Jammed Paper” on page 141
- “Loading Paper in the Rear Paper Feed” on page 47
Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information

➤ “Loading Paper in the Rear Paper Feed” on page 47

Several Sheets of Paper are Fed at a Time

☐ Load one sheet of paper at a time.

☐ When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is loaded in the printer before you reload the paper.

Paper Out Error Occurs

When a paper out error occurs although paper is loaded in the rear paper feed, reload paper in the center of the rear paper feed.

Paper is Ejected During Printing

When you load letterhead paper (paper on which information such as the sender’s name or corporation name are pre-printed in the header), select Letterhead as the paper type setting.

Power and Control Panel Problems

Power Does Not Turn On

☐ Make sure the power cord is securely plugged in.

☐ Hold down the button for a little longer.

Power Does Not Turn Off

Hold down the button for a little longer. If you still cannot turn off the printer, unplug the power cord. To prevent the print head from drying out, turn the printer back on and turn it off by pressing the button.

Power Turns Off Automatically

☐ Select Power Off Settings in Settings, and then disable the Power Off If Inactive and Power Off If Disconnected settings.

☐ Disable the Power Off Timer setting in Settings.
Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

LCD Screen Gets Dark

The printer is in sleep mode. Press any button on the control panel to return the LCD screen to its former state.

Cannot Print from a Computer

Checking the Connection (USB)

- Connect the USB cable securely to the printer and the computer.
- If you are using a USB hub, try to connect the printer directly to the computer.
- If the USB cable cannot be recognized, change the port, or change the USB cable.
- If the printer cannot print using a USB connection, try the following.
  Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and then select Remove Device. Next, connect the USB cable to the computer and try a test print.
  Re-set the USB connection by following the steps in this manual for changing the connection method to a computer. See the related information link below for details.

Checking the Connection (Network)

- When you have changed your wireless router or provider, try making network settings for the printer again.
  Connect the computer or smart device to the same SSID as the printer.
- Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the devices in the following order; wireless router, computer or smart device, and then printer. Move the printer and computer or smart device closer to the wireless router to help with radio wave communication, and then try to make network settings again.

Related Information

⇒ “Changing the Connection Method to a Computer” on page 41
Solving Problems

- Print the network connection report. See the related information link below for details. If the report shows that the network connection failed, check the network connection report and then follow the printed solutions.
- If the IP address assigned to the printer is 169.254.XXX.XXX, and the subnet mask is 255.255.0.0, the IP address may not be assigned correctly. Restart the wireless router or reset the network settings for the printer. If this does not solve the problem, see the documentation for the wireless router.
- Try accessing any website from your computer to make sure that your computer’s network settings are correct. If you cannot access any website, there is a problem on the computer. Check the network connection of the computer.

Related Information
- “Connecting to a Computer” on page 21
- “Printing a Network Connection Report” on page 34

Checking the Software and Data

- Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the available functions are limited. We recommend using a genuine Epson printer driver. See the related information link below for details.
- If you are printing a large data size image, the computer may run out of memory. Print the image at a lower resolution or a smaller size.

Related Information
- “Checking for Genuine Epson Printer Drivers” on page 147
- “Installing Applications” on page 135

Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following methods.

Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to open the print server properties window.

- Windows 10/Windows 8.1/Windows 8/Windows 7
  Click the printer icon, and then click Print server properties at the top of the window.
- Windows Vista
  Right-click on the Printers folder, and then click Run as administrator > Server Properties.
- Windows XP
  From the File menu, select Server Properties.
Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on your computer.

Mac OS

Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a genuine Epson printer driver is installed on your computer.

Related Information

⇒ "Installing Applications" on page 135
Checking the Printer Status from the Computer (Windows)

Click Print Queue on the printer driver’s Maintenance tab, and then check the following.

- Check if there are any paused print jobs.
  - If unnecessary data remains, select Cancel all documents from the Printer menu.
- Make sure the printer is not offline or pending.
  - If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

- Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on the menu item).
  - If the printer is not selected as the default printer, set it as the default printer. If there are multiple icons in Control Panel > View devices and printers (Printers, Printers and Faxes), see the following to select the icon.
    - Example)
      USB connection: EPSON XXXX Series
      Network connection: EPSON XXXX Series (network)
    - If you install the printer driver multiple times, copies of printer driver may be created. If copies such as "EPSON XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove Device.
- Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.
  - Select "USBXXX" for a USB connection, or "EpsonNet Print Port” for a network connection.

Checking the Printer Status from the Computer (Mac OS)

Make sure the printer status is not Pause.

Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then double-click the printer. If the printer is paused, click Resume (or Resume Printer).
When You Cannot Make Network Settings

- Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the devices in the following order; wireless router, computer or smart device, and then printer. Move the printer and computer or smart device closer to the wireless router to help with radio wave communication, and then try to make network settings again.

- Select Settings > Network Settings > Connection Check, and then print the network connection report. If an error has occurred, check the network connection report and then follow the printed solutions.

Related Information
- “Printing a Network Connection Report” on page 34
- “Messages and Solutions on the Network Connection Report” on page 35

Cannot Connect from Devices Even Though Network Settings are No Problems

If you cannot connect from the computer or smart device to the printer even though the network connection report does not show any problems, see the following.

- When you are using multiple wireless routers at the same time, you may not be able to use the printer from the computer or smart device depending on the settings of the wireless routers. Connect the computer or smart device to the same wireless router as the printer.
  
  Disable the tethering function on the smart device if it is enabled.
You may not be able to connect to the wireless router when the wireless router has multiple SSIDs and devices are connected to different SSIDs on the same wireless router. Connect the computer or smart device to the same SSID as the printer.

A wireless router that is compliant with both IEEE802.11a and IEEE802.11g has SSIDs of 2.4 GHz and 5 GHz. If you connect the computer or smart device to a 5 GHz SSID, you cannot connect to the printer because the printer only supports communication over 2.4 GHz. Connect the computer or smart device to the same SSID as the printer.

Most wireless routers have a privacy separator feature that blocks communication between connected devices. If you cannot communicate between the printer and the computer or smart device even if they are connected to the same network, disable the privacy separator on the wireless router. See the manual provided with the wireless router for details.
Related Information

- “Checking the SSID Connected to the Printer” on page 152
- “Checking the SSID for the Computer” on page 152

Checking the SSID Connected to the Printer

You can check the SSID by printing a network connection report, network status sheet, or on Web Config.

Related Information

- “Printing a Network Connection Report” on page 34
- “Printing a Network Status Sheet” on page 40

Checking the SSID for the Computer

Windows

Click in the task tray on the desktop. Check the name of the connected SSID from the list displayed.
Mac OS
Click the Wi-Fi icon at the top of the computer screen. A list of SSIDs is displayed and the connected SSID is indicated with a check mark.

Wireless LAN (Wi-Fi) Connections Become Unstable When Using USB 3.0 Devices on a Mac
When you connect a device to the USB 3.0 port on a Mac, radio frequency interference may occur. Try the following if you cannot connect to wireless LAN (Wi-Fi) or if operations become unstable.

- Place the device that is connected to the USB 3.0 port further away from the computer.
- If the printer supports the 5 GHz frequency range, connect to the SSID for the 5 GHz range.

Related Information
⇒ "Wi-Fi Specifications" on page 170

Cannot Print from an iPhone, iPad, or iPod touch

- Connect the iPhone, iPad, or iPod touch to the same network (SSID) as the printer.
- Enable Paper Setup Auto Display in the following menus.
  - Settings > Printer Setup > Paper Source Settings > Paper Setup Auto Display
- Enable the AirPrint setting on Web Config.

Related Information
⇒ “Connecting to a Smart Device” on page 22
⇒ “Application for Configuring Printer Operations (Web Config)” on page 125
Printout Problems

Printout is Scuffed or Color is Missing

If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not be discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

Related Information

“Checking and Cleaning the Print Head” on page 112

Banding or Unexpected Colors Appear

The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged. Clean the print head if any of the print head nozzles are clogged.

Related Information

“Checking and Cleaning the Print Head” on page 112

Colored Banding Appears at Intervals of Approximately 2.5 cm

- Select the appropriate paper type setting for the type of paper loaded in the printer.
- Align the print head using the Horizontal Alignment feature.
- When printing on plain paper, print using a higher quality setting.
Related Information

- “List of Paper Type” on page 47
- “Aligning the Print Head” on page 114

**Blurry Prints, Vertical Banding, or Misalignment**

Align the print head using the Vertical Alignment feature.

Related Information

- “Aligning the Print Head” on page 114

**Print Quality Does Not Improve Even After Aligning the Print Head**

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and vertical lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed) setting. Disabling this setting may slow down printing speed.

- **Windows**
  - Clear High Speed on the printer driver’s More Options tab.

- **Mac OS**
  - Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed Printing setting.

**Print Quality is Poor**

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and misalignment in the prints.

**Checking the printer**

- Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.
- Align the print head.

**Checking the paper**

- Use paper supported by this printer.
- Do not print on paper that is damp, damaged, or too old.
If the paper is curled or the envelope is puffed up, flatten it.

Do not stack the paper immediately after printing.

Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light, do not use a dryer, and do not touch the printed side of paper.

When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print on the printable side of the genuine Epson paper.

Checking the print settings

Select the appropriate paper type setting for the type of paper loaded in the printer.

Print using a higher quality setting.

Checking the ink cartridge

Epson recommends using the ink cartridge before the date printed on the package.

For best results, use up ink cartridge within six months of opening the package.

Try to use genuine Epson ink cartridges. This product is designed to adjust colors based on the use of genuine Epson ink cartridges. The use of non-genuine ink cartridges may cause print quality to decline.

Related Information

“Checking and Cleaning the Print Head” on page 112

“Aligning the Print Head” on page 114

“Available Paper and Capacities” on page 45

“List of Paper Type” on page 47

“Paper Handling Precautions” on page 44

Paper Is Smeared or Scuffed

When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct direction and slide the edge guides to the edges of the paper.

When vertical banding appears or the paper is smeared, clean the paper path.
Place the paper on a flat surface to check if it is curled. If it is, flatten it.
When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.

Related Information

- "Loading Paper in the Rear Paper Feed" on page 47
- "Cleaning the Paper Path for Ink Smears" on page 114

Paper is Smeared During Automatic 2-Sided Printing

When using the automatic 2-sided printing feature and printing high density data such as images and graphs, set the print density to lower and the drying time to longer.

Related Information

- "Menu Options for Printer Setup" on page 120

Printed Photos are Sticky

You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.
When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

- "Cleaning the Paper Path for Ink Smears" on page 114

Images or Photos are Printed in Unexpected Colors

When printing from the Windows printer driver, the Epson auto photo adjustment setting is applied by default depending on the paper type. Try change the setting.

On the More Options tab, select Custom in Color Correction, and then click Advanced. Change the Scene Correction setting from Auto Correct to any other option. If changing the setting does not work, use any color correction method other than PhotoEnhance in Color Management.

Related Information

- "Adjusting the Print Color" on page 72

Colors Differ from What You See on the Display

- Display devices such as computer screens have their own display properties. If the display is unbalanced, the image are not displayed with proper brightness and colors. Adjust the properties of the device.
- Light shining into the display has an effect on how the image is seen on the display. Avoid direct sunlight and confirm the image where an appropriate illuminance is assured.
- Colors may differ from what you see on smart devices such as smart phones or tablets with high-resolution displays.
Colors on a display are not quite identical to those on paper because the display device and the printer have a different process of producing colors.

**Cannot Print Without Margins**

Make borderless setting in the print settings. If you select a paper type that does not support borderless printing, you cannot select **Borderless**. Select a paper type that supports borderless printing.

**Related Information**

- “Menu Options for Copying” on page 79
- “Printing Basics - Windows” on page 55
- “Printing Basics - Mac OS” on page 57

**Edges of the Image are Cropped During Borderless Printing**

During borderless printing, the image is slightly enlarged and the protruding area is cropped. Select a smaller enlargement setting.

- Control panel
  - Change the **Expansion** setting.
- Windows
  - Click **Settings** next to the **Borderless** checkbox on the printer driver’s **Main** tab, and then change the settings.
- Mac OS
  - Change the **Expansion** setting from the print dialog's **Print Settings** menu.

**The Position, Size, or Margins of the Printout Are Incorrect**

- Load paper in the correct direction, and slide the edge guides against the edges of the paper.
- When placing the originals on the scanner glass, align the corner of the original with the corner indicated by a symbol on the frame of the scanner glass. If the edges of the copy are cropped off, move the original slightly away from the corner.
- When placing the originals on the scanner glass, clean the scanner glass and the document cover using a dry, soft, clean cloth. If there is dust or stains on the glass, the copy area may extend to include the dust or stains, resulting in the wrong copying position or small images.

- Select the appropriate paper size setting.
Solving Problems

- Adjust the margin setting in the application so that it falls within the printable area.

Related Information
- “Loading Paper in the Rear Paper Feed” on page 47
- “Placing Originals on the Scanner Glass” on page 51
- “Cleaning the Scanner Glass” on page 115
- “Printable Area” on page 168

Printed Characters Are Incorrect or Garbled

- Connect the USB cable securely to the printer and the computer.
- Cancel any paused print jobs.
- Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled text may be printed next time you start the computer.
- If you use the printer driver you had previously used, printed characters may be garbled. Make sure that the printer driver you are using is for this printer. Check the printer name on the top of the printer driver window.

The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.

- Windows
  - Clear Mirror Image on the printer driver’s More Options tab.
- Mac OS
  - Clear Mirror Image from the print dialog’s Print Settings menu.

Mosaic-Like Patterns in the Prints

When printing images or photos, print using high-resolution data. Images on websites are often low resolution although they look good enough on the display, and so print quality may decline.

Uneven Colors, Smears, Dots, or Straight Lines Appear in theCopied Image

- Clean the paper path.
- Clean the scanner glass.
- Do not press too hard on the original or the document cover when you are placing the originals on the scanner glass.
- When the paper is smeared, lower the copy density setting.

Related Information
- “Cleaning the Paper Path for Ink Smears” on page 114

159
Moiré (Cross-Hatch) Patterns Appear in the Copied Image

Change the reduce and enlarge setting or place the original at a slightly different angle.

An Image of the Reverse Side of the Original Appears in the Copied Image

- For a thin original, place the original on the scanner glass and then place a piece of black paper over it.
- Lower the copy density setting on the control panel.

Related Information

- “Menu Options for Copying” on page 79

The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the printer driver.

Other Printing Problems

Printing Is Too Slow

- Close any unnecessary applications.
- Lower the quality setting. High quality printing slows down the printing speed.
- Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while moving in both directions, and the printing speed increases.
  - Windows
    Select High Speed on the printer driver’s More Options tab.
  - Mac OS
    Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed Printing setting.
Disable quiet mode. This feature slows down the printing speed.

- Control Panel
  Select on the home screen, and then disable Quiet Mode.

- Windows
  Select Off as the Quiet Mode setting on the printer driver's Main tab.

- Mac OS
  Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode setting.

Printing or Copying Slows Down Dramatically During Continuous Operation

Printing or Copying slows down to prevent the printer mechanism from overheating and being damaged. However, you can continue operation. To return to normal speed, leave the printer idle for at least 30 minutes. The speed does not return to normal if the power is off.

Cannot Cancel Printing from a Computer Running Mac OS X v10.6.8

If you want to stop printing from your computer, make the following settings.

Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and then add the printer again.

Cannot Start Scanning

- Connect the USB cable securely to the printer and the computer. If you are using a USB hub, try to connect the printer directly to the computer.

- If you scan at a high resolution over a network, a communication error may occur. Lower the resolution.

- Make sure that the correct printer (scanner) is selected on Epson Scan 2.

Check whether or not the printer is recognized when using Windows

In Windows, make sure the printer (scanner) is displayed in Scanner and Camera. The printer (scanner) should be displayed as "EPSON XXXXX (printer name)". If the printer (scanner) is not displayed, uninstall and then re-install Epson Scan 2. See the following to access Scanner and Camera.

- Windows 10
  Click on the start button, and then select Windows System > Control Panel, enter "Scanner and Camera” in the search charm, click View scanners and cameras, and then check if the printer is displayed.

- Windows 8.1/Windows 8
  Select Desktop > Settings > Control Panel, enter "Scanner and Camera” in the search charm, click Show Scanner and Camera, and then check if the printer is displayed.
Solving Problems

- **Windows 7**
  Click the start button and select **Control Panel**, enter "Scanner and Camera" in the search charm, click **View scanners and cameras**, and then check if the printer is displayed.

- **Windows Vista**
  Click the start button, select **Control Panel > Hardware and Sound > Scanners and Cameras**, and then check if the printer is displayed.

- **Windows XP**
  Click the start button, select **Control Panel > Printers and Other Hardware > Scanner and Cameras**, and then check if the printer is displayed.

**Related Information**
- “Uninstalling Applications” on page 137
- “Installing Applications” on page 135

**Cannot Start Scanning when Using the Control Panel**

- Make sure Epson Scan 2 and Epson Event Manager are installed correctly.
- Check the scanning setting assigned in Epson Event Manager.

**Scanned Image Problems**

**Uneven Colors, Dirt, Spots, and so on Appear when Scanning from the Scanner Glass**

- Clean the scanner glass.
- Remove any trash or dirt that adheres to the original.
- Do not press with too much force on the original or the document cover. If you press with too much force, blurring, smudges, and spots may occur.

**Related Information**
- “Cleaning the Scanner Glass” on page 115

**The Image Quality Is Rough**

- Set the **Mode** in Epson Scan 2 according to the original you want to scan. Scan using the settings for documents in **Document Mode**, and the settings for photos in **Photo Mode**.
- In Epson Scan 2, adjust the image using items on the **Advanced Settings** tab, and then scan.
- If the resolution is low, try increasing the resolution and then scanning.
Related Information

⇒ “Scanning Using Epson Scan 2” on page 88

Offset Appears in the Background of Images

Images on the back of the original may appear in the scanned image.

■ In Epson Scan 2, select the Advanced Settings tab, and then adjust the Brightness.
  This feature may not be available depending on the settings on the Main Settings tab > Image Type or other settings on the Advanced Settings tab.

■ In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text Enhancement.

■ When scanning from the scanner glass, place black paper or a desk pad over the original.

Related Information

⇒ “Placing Originals” on page 51

Text is Blurred

■ In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text Enhancement.

■ Select Document Mode as the Mode in Epson Scan 2. Scan using the settings for documents in Document Mode.

■ In Document Mode in Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White, adjust Threshold on the Advanced Settings tab. When you increase the Threshold, the black color area becomes larger.

■ If the resolution is low, try increasing the resolution and then scanning.

Related Information

⇒ “Scanning Documents (Document Mode)” on page 88

Moiré Patterns (Web-Like Shadows) Appear

If the original is a printed document, moiré patterns (web-like shadows) may appear in the scanned image.

■ On the Advanced Settings tab in Epson Scan 2, set Descreening.

■ Change the resolution, and then scan again.
Solving Problems

Related Information

- “Scanning Using Epson Scan 2” on page 88

Cannot Scan the Correct Area on the Scanner Glass

- Make sure the original is placed correctly against the alignment marks.
- If the edge of the scanned image is missing, move the original slightly away from the edge of the scanner glass.
- When placing multiple originals on the scanner glass, make sure there is a gap of at least 20 mm (0.79 in.) between the originals.
- When scanning from the control panel and selecting the auto scan area cropping function, remove any trash or dirt from the scanner glass and document cover. If there is any trash or dirt around the original, the scanning range expands to include it.

Related Information

- “Placing Originals” on page 51
- “Cleaning the Scanner Glass” on page 115

Cannot Preview in Thumbnail

- When placing multiple originals on the scanner glass, make sure there is a gap of at least 20 mm (0.79 in.) between the originals.
- Check that the original is placed straight.
- Depending on the original, previewing may not be performed in Thumbnail. In this situation, clear the Thumbnail check box at the top of the preview widow to preview the entire scanned area, and then create marquees manually.

Related Information

- “Scanning Using Epson Scan 2” on page 88

Text is Not Recognized Correctly when Saving as a Searchable PDF

- On the Image Format Options window in Epson Scan 2, check that Text Language is set correctly on the Text tab.
- Check that the original is placed straight.
- Use an original with clear text. Text recognition may decline for the following types of originals.
  - Originals that have been copied a number of times
  - Originals received by fax (at low resolutions)
  - Originals on which the letter spacing or line spacing is too small
  - Originals with ruled lines or underlining over the text
  - Originals with hand-written text
  - Originals with creases or wrinkles
In *Document Mode* in Epson Scan 2, when *Image Type* on the *Main Settings* tab is set to *Black & White*, adjust *Threshold* on the *Advanced Settings* tab. When you increase the *Threshold*, black becomes stronger.

In *Document Mode* in Epson Scan 2, select the *Advanced Settings* tab, and then *Image Option > Text Enhancement*.

**Related Information**

⇒ “Scanning Documents (Document Mode)” on page 88

**Cannot Solve Problems in the Scanned Image**

If you have tried all of the solutions and have not solved the problem, initialize the Epson Scan 2 settings using Epson Scan 2 Utility.

*Note:*

*Epson Scan 2 Utility is an application that comes with Epson Scan 2.*

1. Start Epson Scan 2 Utility.
   - Windows 10
     Click the start button, and then select **EPSON > Epson Scan 2 Utility**.
   - Windows 8.1/Windows 8
     Enter the application name in the search charm, and then select the displayed icon.
   - Windows 7/Windows Vista/Windows XP
     Click the start button, and then select **All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility**.
   - Mac OS
     Select **Go > Applications > Epson Software > Epson Scan 2 Utility**.

2. Select the *Other* tab.

3. Click *Reset*.

   *Note:*

   *If initialization does not solve the problem, uninstall and re-install Epson Scan 2.*

**Related Information**

⇒ “Uninstalling Applications” on page 137

⇒ “Installing Applications” on page 135

**Other Scanning Problems**

**Scanning Is Too Slow**

Lower the resolution.
Scanning Slows Down Dramatically During Continuous Scanning

Scanning slows down to prevent the printer mechanism from overheating and being damaged. However, you can continue scanning. To return to normal scanning speed, leave the printer idle for at least 30 minutes. Scanning speed does not return to normal if the power is off.

Scanning Stops when Scanning to PDF/Multi-TIFF

- When scanning using Epson Scan 2, you can continuously scan up to 999 pages in PDF format and up to 200 pages in Multi-TIFF format.
- When scanning large volumes, we recommend scanning in grayscale.
- Increase the free space on the computer’s hard disk. Scanning may stop if there is not enough free space.
- Try scanning at a lower resolution. Scanning stops if the total data size reaches the limit.

Other Problems

Slight Electric Shock when Touching the Printer

If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer. Install a ground wire to the computer that is connected to the printer.

Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

- Control panel
  - Select on the home screen, and then enable Quiet Mode.
- Windows printer driver
  - Enable Quiet Mode on the Main tab.
- Mac OS printer driver
  - Select System Preferences from the menu > Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.
Solving Problems

Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.
Appendix

Technical Specifications

Printer Specifications

<table>
<thead>
<tr>
<th>Print Head Nozzle Placement</th>
<th>Black ink nozzles: 180</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Color ink nozzles: 59 for each color</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weight of Paper*</th>
<th>Plain Paper</th>
<th>64 to 90 g/m² (17 to 24lb)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>Envelope #10, DL, C6: 75 to 90 g/m² (20 to 24 lb)</td>
<td></td>
</tr>
</tbody>
</table>

* Even when the paper thickness is within this range, the paper may not feed in the printer or the print quality may decline depending on the paper properties or quality.

Printable Area

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism.

Printing with borders

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>3.0 mm (0.12 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B</td>
<td>3.0 mm (0.12 in.)</td>
</tr>
<tr>
<td></td>
<td>C</td>
<td>41.0 mm (1.61 in.)</td>
</tr>
<tr>
<td></td>
<td>D</td>
<td>37.0 mm (1.46 in.)</td>
</tr>
</tbody>
</table>

Borderless printing

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>44.0 mm (1.73 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B</td>
<td>40.0 mm (1.57 in.)</td>
</tr>
</tbody>
</table>
**Appendix**

**Printable Area for Envelopes**
Print quality may decline in the shaded areas due to the printer’s mechanism.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>3.0 mm (0.12 in.)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>5.0 mm (0.20 in.)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>18.0 mm (0.71 in.)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>41.0 mm (1.61 in.)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Scanner Specifications**

<table>
<thead>
<tr>
<th>Scanner Type</th>
<th>Flatbed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoelectric Device</td>
<td>CIS</td>
</tr>
<tr>
<td>Maximum Document Size</td>
<td>216×297 mm (8.5×11.7 in.)</td>
</tr>
<tr>
<td></td>
<td>A4, Letter</td>
</tr>
<tr>
<td>Resolution</td>
<td>1200 dpi (main scan)</td>
</tr>
<tr>
<td></td>
<td>2400 dpi (sub scan)</td>
</tr>
<tr>
<td>Color Depth</td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td>48 bits per pixel internal (16 bits per pixel per color internal)</td>
</tr>
<tr>
<td></td>
<td>24 bits per pixel external (8 bits per pixel per color external)</td>
</tr>
<tr>
<td>Grayscale</td>
<td>16 bits per pixel internal</td>
</tr>
<tr>
<td></td>
<td>8 bits per pixel external</td>
</tr>
<tr>
<td>Black and white</td>
<td>16 bits per pixel internal</td>
</tr>
<tr>
<td></td>
<td>1 bits per pixel external</td>
</tr>
<tr>
<td>Light Source</td>
<td>LED</td>
</tr>
</tbody>
</table>

**Interface Specifications**

<table>
<thead>
<tr>
<th>For Computer</th>
<th>Hi-Speed USB</th>
</tr>
</thead>
</table>
## Network Function List

### Network Functions and IPv4/IPv6

<table>
<thead>
<tr>
<th>Functions</th>
<th>Supported</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Printing</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EpsonNet Print (Windows)</td>
<td>IPv4</td>
<td>✓</td>
</tr>
<tr>
<td>Standard TCP/IP (Windows)</td>
<td>IPv4, IPv6</td>
<td>✓</td>
</tr>
<tr>
<td>WSD Printing (Windows)</td>
<td>IPv4, IPv6</td>
<td>✓ Windows Vista or later</td>
</tr>
<tr>
<td>Bonjour Printing (Mac OS)</td>
<td>IPv4, IPv6</td>
<td>✓</td>
</tr>
<tr>
<td>IPP Printing (Windows, Mac OS)</td>
<td>IPv4, IPv6</td>
<td>✓</td>
</tr>
<tr>
<td>UPnP Printing</td>
<td>IPv4</td>
<td>- Information appliance</td>
</tr>
<tr>
<td>PictBridge Printing (Wi-Fi)</td>
<td>IPv4</td>
<td>- Digital camera</td>
</tr>
<tr>
<td>Epson Connect (Email Print, Remote Print)</td>
<td>IPv4</td>
<td>✓ -</td>
</tr>
<tr>
<td>AirPrint (iOS, Mac OS)</td>
<td>IPv4, IPv6</td>
<td>✓ iOS 5 or later, Mac OS X v10.7 or later</td>
</tr>
<tr>
<td>Google Cloud Print</td>
<td>IPv4, IPv6</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Network Scanning</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Scan 2</td>
<td>IPv4, IPv6</td>
<td>✓</td>
</tr>
<tr>
<td>Event Manager</td>
<td>IPv4</td>
<td>✓</td>
</tr>
<tr>
<td>Epson Connect (Scan to Cloud)</td>
<td>IPv4</td>
<td>-</td>
</tr>
<tr>
<td>AirPrint (Scan)</td>
<td>IPv4, IPv6</td>
<td>✓ OS X Mavericks or later</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send a fax</td>
<td>IPv4</td>
<td>-</td>
</tr>
<tr>
<td>Receive a fax</td>
<td>IPv4</td>
<td>-</td>
</tr>
<tr>
<td>AirPrint (Faxout)</td>
<td>IPv4, IPv6</td>
<td>-</td>
</tr>
</tbody>
</table>

### Wi-Fi Specifications

<table>
<thead>
<tr>
<th>Standards</th>
<th>IEEE802.11b/g/n(^1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Range</td>
<td>2.4 GHz</td>
</tr>
<tr>
<td>Maximum Radio-Frequency Power Transmitted</td>
<td>20 dBm (EIRP)</td>
</tr>
<tr>
<td>Coordination Modes</td>
<td>Infrastructure, Wi-Fi Direct (Simple AP)(^2)*(^3)</td>
</tr>
<tr>
<td>Wireless Securities(^4)</td>
<td>WEP (64/128bit), WPA2-PSK (AES)(^5)</td>
</tr>
</tbody>
</table>
Appendix

*1 IEEE802.11n is only available for the HT20.

*2 Not supported for IEEE 802.11b.

*3 Simple AP mode is compatible with a Wi-Fi connection (infrastructure).

*4 Wi-Fi Direct supports WPA2-PSK (AES) only.

*5 Complies with WPA2 standards with support for WPA/WPA2 Personal.

Security Protocol

| SSL/TLS          | HTTPS Server/Client, IPPS |

Supported Third Party Services

<table>
<thead>
<tr>
<th>AirPrint</th>
<th>Print</th>
<th>iOS 5 or later/Mac OS X v10.7.x or later</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Scan</td>
<td>OS X Mavericks or later</td>
</tr>
</tbody>
</table>

Google Cloud Print

Dimensions

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width: 375 mm (14.8 in.)</td>
</tr>
<tr>
<td></td>
<td>Depth: 300 mm (11.8 in.)</td>
</tr>
<tr>
<td></td>
<td>Height: 170 mm (6.7 in.)</td>
</tr>
</tbody>
</table>

| Printing        | Width: 375 mm (14.8 in.)                                               |
|                 | Depth: 578 mm (22.8 in.)                                               |
|                 | Height: 242 mm (9.5 in.)                                               |

Weight* Approx. 4.3 kg (9.5 lb)

* Without the ink cartridges and the power cord.

Electrical Specifications

<table>
<thead>
<tr>
<th>Model</th>
<th>100 to 240 V Model</th>
<th>220 to 240 V Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated Frequency</td>
<td>50 to 60 Hz</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Rated Current</td>
<td>0.4 to 0.2 A</td>
<td>0.2 A</td>
</tr>
</tbody>
</table>
Power Consumption (with USB Connection)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Consumption (W)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone copying</td>
<td>Approx. 12.0 W</td>
</tr>
<tr>
<td>(ISO/IEC24712)</td>
<td>(ISO/IEC24712)</td>
</tr>
<tr>
<td>Ready mode</td>
<td>Approx. 5.0 W</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>Approx. 0.8 W</td>
</tr>
<tr>
<td>Power off</td>
<td>Approx. 0.3 W</td>
</tr>
</tbody>
</table>

Note:

- Check the label on the printer for its voltage.
- For European users, see the following Website for details on power consumption.
  http://www.epson.eu/energy-consumption

Environmental Specifications

<table>
<thead>
<tr>
<th>Operation</th>
<th>Use the printer within the range shown in the following graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>10 to 35°C (50 to 95°F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>20 to 80% RH (without condensation)</td>
</tr>
</tbody>
</table>

Storage

| Temperature   | -20 to 40°C (-4 to 104°F)*                                      |
| Humidity      | 5 to 85% RH (without condensation)                             |

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Cartridges

| Temperature   | -30 to 40 °C (-22 to 104 °F)*                                   |

Freezing Temperature

| Temperature   | -16 °C (3.2 °F)                                                |
|               | Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F). |

* You can store for one month at 40 °C (104 °F).

System Requirements

- Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2 or later
- macOS Mojave/macOS High Sierra/macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac OS X v10.7.x/Mac OS X v10.6.8
Note:
- Mac OS may not support some applications and features.
- The UNIX File System (UFS) for Mac OS is not supported.

Regulatory Information

Standards and Approvals

Standards and Approvals for European Model

For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.

http://www.epson.eu/conformity

C636A

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg, Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece, Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the products.

Standards and Approvals for Australian Model

<table>
<thead>
<tr>
<th>EMC</th>
<th>AS/NZS CISPR32 Class B</th>
</tr>
</thead>
</table>

Epson hereby declares that the following equipment Models are in compliance with the essential requirements and other relevant provisions of AS/NZS4268:

C636A

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the products.

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.

Copying of the following items is prohibited by law:
- Bank bills, coins, government-issued marketable securities, government bond securities, and municipal securities
- Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage
Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

- Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession tickets, etc.
- Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

*Note:* 
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before copying published material.

---

**Transporting and Storing the Printer**

When you need to transport the printer to move or for repairs, follow the steps below to pack the printer.

---

**Caution:**

Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.

---

**Important:**

- When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down; otherwise ink may leak.

- Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the printer from printing.

---

1. Turn off the printer by pressing the power button.

2. Make sure the power light turns off, and then unplug the power cord.

**Important:**

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home position causing the ink to dry, and printing may become impossible.
3. Disconnect all cables such as the power cord and USB cable.

4. Remove all of the paper from the printer.

5. Make sure there are no originals on the printer.

6. Open the scanner unit with the document cover closed. Secure the ink cartridge holder to the case with tape.

7. Close the scanner unit.
   
   For safety, the scanner unit is closed in two steps.

   ![Images showing the process of closing the scanner unit]

   **Note:**
   The scanner unit cannot be opened from the position shown below. Close it completely before opening it.
8. Prepare to pack the printer as shown below.

9. Pack the printer in its box, using the protective materials. When you use the printer again, make sure you remove the tape securing the ink cartridge holder. If print quality has declined the next time you print, clean and align the print head.

Related Information

- “Part Names and Functions” on page 14
- “Checking and Cleaning the Print Head” on page 112
- “Aligning the Print Head” on page 114

Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services for assistance.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting information in your product manuals, contact Epson support services for assistance. If Epson support for your area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:
Appendix

- Product serial number
  (The serial number label is usually on the back of the product.)
- Product model
- Product software version
  (Click About, Version Info, or a similar button in the product software.)
- Brand and model of your computer
- Your computer operating system name and version
- Names and versions of the software applications you normally use with your product

Note:
Depending on the product, network settings may be stored in the product's memory. Due to breakdown or repair of a product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings even during a warranty period. We recommend that you make your own backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product manuals, we provide the following sources for obtaining information:

Internet URL
http://www.epson.com.au
Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The site provides a download area for drivers, Epson contact points, new product information and technical support (e-mail).

Epson Helpdesk
Phone: 1300-361-054
Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare, the faster we can help solve the problem. This information includes your Epson product manuals, type of computer, operating system, application programs, and any information you feel is required.

Transportation of Product
Epson recommends retaining product packaging for future transportation.
Help for Users in New Zealand

Epson New Zealand wishes to provide you with a high level of customer service. In addition to your product documentation, we provide the following sources for obtaining information:

Internet URL

http://www.epson.co.nz
Access the Epson New Zealand World Wide Web pages. Worth taking your modem here for the occasional surf!
The site provides a download area for drivers, Epson contact points, new product information and technical support (e-mail).

Epson Helpdesk

Phone: 0800 237 766
Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many types of queries are answered here.
We encourage you to have all the relevant information on hand when you ring. The more information you prepare, the faster we can help solve the problem. This information includes your Epson product documentation, type of computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation.